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Peta Indeks Bahaya dan Kerentanan Fisik Tanah Longsor
Menggunakan Aplikasi Sistem Informasi Geografis (SIG)

(Studi Kasus: Kecamatan Banjarsari Kabupaten Lebak)

Bagus Firmansyah

INTISARI

Indonesia merupakan negara yang memiliki intensitas bencana alam yang cukup
tinggi diantaranya tanah longsor, tsunami, gempa bumi, letusan gunung merapi,
banjir, angin puting beliung, dan kebakaran hutan. Salah satuwilayah Indonesia
yang memiliki bahaya dan kerentanan tanah longsor adalah Kabupaten Lebak
Terdapat tujuh kecamatan yang menjadi pusat krisis banjir dan tanah longsor di
kabupaten lebak diantaranya kecamatan Banjarsari, bojongmanik, gunung kencana,
leuwi damar, kalang anyar, cimarga, muncang pada tanggal 03-01-2023 (Pusat
Krisis Kemenkes RIL, 2023). Tujuan penelitian ini untuk mendapatkan peta
indeks bahaya dan kerentanan fisik tanah longsor dilakukan dengan
menggunakan metode tumpang susun (overlay) menggunakanSistem Informasi
Geografis (SIG). Parameter yang digunakan diantaranyaketinggian, kemiringan
lereng, jenis batuan , jenis tanah, potensi pergerakan tanah, batas desa, dan titik
fisik. Tingkat bahaya dibagi menjadi 3 kelas yaitu tinggi, sedang, dan rendah.
Hasil penelitian ini didapat peta indeks bahaya tanah longsor (Gambar 5.8) dan
kerentanan fisik tanah longsor (Gambar 5.12) di kecamatan banjarsari Kabupaten
Lebak. Berdasarkan aspek fisik Kecamatan Banjarsari Kabupaten Lebak dengan
jumlah total 12.724 titik yang memiliki tingkat kerentanan terbesar diantaranya :
pada kategori rendah yaitu pemukiman/rumah dengan jumlah 3887 titik atau 97 %
dari 4.007 titik, kategori sedang pada pemukiman/rumah dengan jumlah 7.781 titik
atau 95% dari 8.139 titik, dan pada tinggi yaitu pemukiman/rumah dengan jumlah
558 titik atau 96% dari 578 titik.

Kata kunci: bahaya, ker tanah 1 , SIG
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Landslide Physical Vulnerability and Hazard Index Map Using Geographic
Information System (GIS) Application (Case Study: Banjarsari District,
Lebak Regency)

Bagus Firmansyah

ABSTRACT
Indonesia is a country that has a fairly high intensity of natural disasters including landslides,

tsunamis, earthquakes, volcanic eruptions, floods, tornadoes, and forest fires. One of the areas
in Indonesia that is in danger and vilnerable to landslide is Lebak Regency. Seven sub-districts
are the center of the flood and landslide crisis in Lebak Regency, including Banjarsari,
Bojongmanik, Guaung Kencana, Leuwi Damar, Kalang Anyar, Cimarga, Muncang sub-
distriets on 03-01-2023 (Crisis Center of the Ministry of Health of the Republic of Indonesia,
2023). The purpose of this study was to obtain a map of the physical hazards and vulnerability
index of landslides using the overlay method of the Geographic Information System (GIS). The
parameters used include height, slope, rock type, soil type, potential for land movement, village
boundaries, and physical points. The level of danger is divided into 3 classes, namely high,
medium, and low. The results of this study obtained a landslide hazard index map (Figure 5.8)
and the physical vulnerability of landslides (Figure 5.12) in Banjarsari District, Lebak
Regency. Based on the physical aspects of Banjarsari District, Lebak Regency with a total of
12,724 points that have the highest level of vulnerability including : in the low category, namely
settlements/houses with a total of 3887 points or 97% of 4,007 points, the medium category in
settlementsthouses with a total of 7,781 points or 95% of 8,139 points,and in the high category,

namely settlements/houses with a total of 558 points or 96% of 578 points.

Keywords: hazard, vulnerability, landslide, GIS
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BAB 1
PENDAHULUAN

1.1 Latar Belakang

Indonesia merupakan negara yang memiliki intensitas bencana alam yang cukup
tinggi diantaranya tanah longsor, tsunami, gempa bumi, letusan gunung merapi,
banjir, angin puting beliung, dan kebakaran hutan. Indonesia sebagai Negara
kepulauan yang cukup luas memerlukan adanya teknologi monitoring dan

pemantauan wilayah yang terkena bencana seacra cepat, akurat, efektif dan efisien.

Bencana alam adalah salah satu fenomena yang dapat terjadi setiap saat, dimanapun
dan kapanpun sehingga dapat menimbulkan resiko atau bahya terhadap kehidupan
manusia, baik kerugian harta benda maupun korban jiwa (Nugroho. dkk, 2009).
Bencana tanah longsor merupakan salah satu bencana alam geologi yang dapat
menimbulkan korban jiwa dan kerugian material yang sangat besar, seperti
terjadinya pendangkalan, terganggunya jalur lalu lintas, rusaknya lahan pertanian,

pemukiman, jembatan, saluran irigasi dan prasarana fisik lainya.

DAMPYUK BENCANA ALAM PERIDOE 1 A1

0858 s 146144534 s
§ 37w  § 873304

Gambar 1.1 Kerawanan Bencana
(Sumber : Google, 2024)

Potensi terjadinya pada lereng tergantung pada kondisi batuan dan tanah

penyusunannya, struktur geologi, curah hujan dan penggunaan lahan. Tanah




longsor umumnya terjadi pada musim hujan dengan curah hujan yang tinggi.
Proses terjadinya beberapa bencana alam diataranya tanah longsor disebagian
wilayah kabupaten Lebak, yaitu dikecamatan Banjarsari pada tanggal 06-08-2021
diakibatkan oleh hujan dengan intensitas yang sangat tinggi dan menyebabkan
tertutupnya ruas jalan disebagian daerah tersebut (BBC, 2021). Kecamatan yang
masuk daerah rawan tanah longsor dan banjir di Kabupaten Lebak berdasarkan
pemetaan BPBD itu tersebar di Kecamatan Bayah, Cilograng, Cibeber,
Panggarangan, Cihara, Wanasalam, Gunungkencana, Malingping, Cigemblong
Banjarsari, Cileles, Cikulur, Warunggunung, Maja, Kalanganyar, Lebakgedong,
Bojongmanik, Sobang, Rangkasbitung, Muncang, Cipanas, Cimarga, Leuwidamar
dan Curugbitung.

Salah satu kabupaten di Provinsi Banten adalah Kabupaten Lebak. Rangkasbitung
adalah ibu kotanya. Kabupaten ini berbatasan dengan Samudera Hindia di sebelah
selatan, Kabupaten Bogor dan Sukabumi di sebelah timur, Kabupaten Serang dan
Tangerang di sebelah utara, dan Kabupaten Pandeglang di sebelah barat. Dari 28
kecamatan yang ada di Kabupaten Lebak, dibagi lagi menjadi 340 desa dan 5
kelurahan. Koordinat geografis Kabupaten Lebak adalah 6 18' - 7 00' LS dan 105
25' - 106 30" BT. Wilayah selatan kabupaten yang berbatasan dengan Kabupaten
Bogor dan Kabupaten Sukabumi ini merupakan daerah pegunungan, dengan
Gunung Halimun di ujung tenggara. Wilayah utara kabupaten ini merupakan
dataran rendah.

Terdapat tujuh kecamatan yang menjadi pusat krisis banjir dan tanah longsor di
kabupaten lebak diantaranya kecamatan Banjarsari, bojongmanik, gunung kencana,
leuwi damar, kalang anyar, cimarga, muncang pada tanggal 03-01-2023 (Pusat
Krisis Kemenkes RI, 2023). Dari hasil analisis yang telah terlebih dahulu
disimulasikan kecamatan banjarsari merupakan daerah yang rentan berpotensi
mengalami tanah longsor. Hal ini diperkuat oleh data catatan kejadian bencana
kabupaten lebak yang berikan oleh BNPB dan media berita lainya. Oleh karena itu
Penulis Menetapkan Kecamatan Banjarsari, Kabupaten Lebak sebagai lokasi
penelitian ini.

1.2 Rumusan Masalah

Berdasarkan latar belakang diatas, maka didapatkan rumusan masalah penelitian




sebagai berikut :

a. Bagaimana peta indeks bahaya tanah longsor di wilayah Kecamatan Banjarsari
Kabupaten Lebak?

b. Bagaimana peta kerentanan fisik tanah longsor di wilayah Kecamatan

Banjarsari Kabupaten Lebak?

1.3 Tujuan Penelitian
Berdasarkan latar belakang di atas maka tujuan dari penelitian yang ingin dicapai
dari penelitian ini adalah :

a. Mendapatkan peta indeks bahaya tanah longsor di wilayah Kecamatan Banjarsari
Kabupaten Lebak.

b. Mendapatkan data kerentanan (Fisik) tanah longsor di wilayah Kecamatan

Banjarsari Kabupaten Lebak.

1.4 Batasan Penelitian

Untuk memperjelas permasalahan dan memudahkan dalam menganalisa, maka

dibuat batasan masalah sebagai berikut :

a. Lokasi penelitian dilakukan disebagian wilayah Kabupaten Lebak, yaitu kecamatan
Banjarsari

b. Melakukan analisis spasial menggunakan aplikasi QuantumGIS (QGIS)

¢. Menginterpretasikan dan melakukan analisis terhadap ourput berupa peta yang
sudah dihasilkan dari proses analisis spasial dengan metode Overlay (peta Indeks

bahaya dan Kerentanan Fisik).

1.5 Manfaat Penelitian

Manfaat dari penelitian ini maka dibuat sebagai berikut :

a. Penelitian ini diharapkan dapat memberikan kontribusi bagi pengembangan ilmu
dan sebagai bahan acuan bagi peneliti selanjutnya

b. Penelitian ini diharapkan dapat memberikan informasi bagi masyarakat
Kabupaten Lebak terutama masyarakat di wilayah yang berpotensi terjadi tanah
longsor mengenai zona bahaya dan kerentanan tanah longsor.

¢. Memberikan masukan ke pemerintah dacrah Kabupaten Lebak tentang peta

bahaya dan kerentanan tanah longsor agar bisa dilakukan upaya mitigasi.

1.6 Ruang Lingkup Penelitian

Ruang lingkup penelitian berada di wilayah Kabupaten Lebak Provinsi Banten.




Lokasi Penelitian dapat dilihat pada gambar 1.2. Tinjauan penelitian ini di wilayah
Kabupaten Lebak yang menjadi daerah tinjauan yaitu: wilayah Kecamatan

Banjarsari.
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Gambar 1.2 Peta Administrasi Kabupaten Lebak
(Sumber : lebakab, 2024)

1.7 Keaslian Penelitian

Penelitian mengenai Peta Bahaya dan Kerentanan Tanah Longsor Menggunakan
Aplikasi Sistem Informasi Geografis (SIG). (Studi Kasus : Wilayah Kecamatan
Banjarsari Kabupaten Lebak) belum pernah dilakukan sehingga hasil pembahasan

merupakan hasil analisa penulis.




BAB 2
TINJAUAN PUSTAKA

2.1 Tinjauan Pustaka

Rakuasa & Rifai, (2020). Pemetaan kerentanan bencana tanah longsor berbasis
sitem informasi geografis di kota ambon. Penelitian ini bertujuan untuk mengetahui
tingkat kerentanan longsor, sebaran longsor di Kota Ambon dan upaya mitigasi di
Kota Ambon. Untuk menghindari kerugian akibat bencana tersebut dilakukan
tindakan pengelolaan resiko bencana yaitu dengan Pemetaan kerentanan bencana
tanah longsor berbasis Sistem Informasi Geografis (GIS). Variabel yang digunakan
dalam penelitian ini meliputi variabel ketinggian lahan/elevasi, jenis tanah, curah
hujan, geologi, penggunanan lahan/land use. Penentuan titik sampel berdasarkan
daerah yang sering terjadi tanah longsor. Pengambilan data dalam penelitian ini
menggunakan metode observasi dan dokumentasi. Hasil penelitian menunjukkan
bahwa terdapat tiga klasifikasi risiko longsor di Kota Ambon, yaitu rendah, sedang,
dan tinggi. Luas masing-masing adalah 5.957,67 Ha (17,81%), 18.584,58 Ha
(55,57%), dan 8.900,11 Ha (26,61%).

Armnas dkk, (2020). Pemanfaatan Informasi Spasial Berbasis SIG untuk Pemetaan
Tingkat Kerawanan Longsor di Kabupaten Bandung Barat, Jawa Barat. Proses
pembuatan peta yang menggambarkan potensi dampak negatif di suatu wilayah
dikenal sebagai pemetaan risiko bencana (Aditya, 2010). Melalui identifikasi dan
evaluasi masalah-masalah yang diakibatkan oleh tanah longsor, penggunaan
teknologi informasi spasial berbasis SIG dapat membantu upaya mitigasi. Agar
hasil penelitian ini dapat digunakan sebagai panduan dalam upaya mitigasi,
khususnya terkait longsor, penelitian ini bertujuan untuk memetakan tingkat
kerentanan longsor di Kabupaten Bandung Barat, Jawa Barat, dengan
menggunakan informasi spasial berbasis SIG.

Kabupaten Bandung Barat memiliki kerentanan longsor sedang hingga tinggi,
menurut hasil penggunaan SIG ini. Empat kecamatan memiliki kerentanan longsor
rendah, tujuh kecamatan memiliki kerentanan longsor sedang, dua belas kecamatan
memiliki kerentanan longsor tinggi. dan tiga kecamatan memiliki kerentanan

longsor sangat tinggi. Kecamatan Parongpong, Cisarua, dan Lembang memiliki




risiko longsor yang sangat tinggi. Oleh karena itu, sangat penting untuk
menginformasikan kepada masyarakat tentang cara-cara untuk mengurangi daerah
rawan longsor..

Deamasari Dwi Rusdiana dkk, (2021). Penggunaan Data Spasial Berbasis SIG
untuk Memetakan Tingkat Bahaya Tanah Longsor di Kabupaten Karangasem, Bali.
Tujuan dari penelitian ini adalah untuk memetakan tingkat bahaya tanah longsor
dan memberikan data lokasi rawan tanah longsor di Kabupaten Karangasem, Bali.
Diharapkan temuan penelitian ini dapat mengurangi dampak bencana di Kabupaten
Karangasem, Bali, dan menjadi panduan untuk kegiatan mitigasi. Pendekatan
weighted overlay yang menggunakan SIG berdasarkan data raster dan pengolahan
citra untuk menilai kemungkinan terjadinya tanah longsor di Kabupaten
Karangasem dapat digunakan untuk mendapatkan parameter-parameter yang
diperlukan. Karena cara kerja pendekatan Weighted Overlay, yang melibatkan
pemberian bobot yang berbeda-beda pada setiap data masukan sesuai dengan
tingkat signifikansi atau pengaruhnya, pendekatan ini dianggap sebagai alat yang
sangat membantu dalam menampilkan kemungkinan terjadinya longsor di wilayah
Karangasem. Beberapa nilai yang rendah berada di wilayah kecil antara perbatasan
Kecamatan Manggis dan Sideman, Kecamatan Kubu, Abang, Karangasem, Selat,
Bebandem, dan Rendang yaitu kurang dari 15%. Wilayah dengan potensi longsor
sedang hingga tinggi sebesar 25-62% berada di bagian timur Kecamatan Abang,
bagian timur laut Kecamatan Karangasem, bagian selatan Kecamatan Kubu, bagian
timur Kecamatan Rendang, dan bagian utara Kecamatan Bebandem dan Selat.
Muhammad Farhan Yasar dkk, (2020). Penerapan Weighted Overlay Pada
Pemetaan Tingkat Probabilitas Zona Rawan Longsor di Kabupaten Sumedang,
Jawa Barat. Pemetaan dan penyediaan informasi mengenai daerah rawan longsor di
Kabupaten Sumedang merupakan tujuan dari penelitian ini. Temuan penelitian ini
diharapkan dapat mengurangi dampak bencana tanah longsor di Kabupaten
Sumedang dan diharapkan dapat menjadi panduan untuk kegiatan mitigasi.
Kabupaten Sumedang memiliki risiko tanah longsor sedang hingga tinggi, menurut
penelitian yang telah dilakukan. Hal ini disebabkan oleh intensitas curah hujan di
Kabupaten Sumedang yang sangat tinggi, yaitu berkisar antara 4.201-5.196 mm per

tahun. Jenis tanah yang mendominasi adalah tanah aluvial, diikuti oleh jenis batuan




vulkanik, dan tingkat kemiringan lereng yang didominasi oleh lereng 15-30% dan
lebih dari 45%. Nilai yang tinggi dari salah satu karakteristik ini akan berdampak
dan meningkatkan kemungkinan terjadinya bencana tanah longsor. Kita dapat
menampilkan wilayah yang termasuk dalam zona rawan longsor dalam penelitian
ini. Kita dapat mencari referensi yang sesuai dengan teknik agihan untuk studi
selanjutnya.

Muhh. Rizal Darwis dkk, (2021). Pemetaan Zonasi Daerah Rawan Bencana
Longsor Berbasis Sistem Informasi Geografis Di DAS Jeneberang Kabupaten
Gowa.. bertujuan untuk mengetahui tingkat kerawanan dan sebaran daerah yang
berpotensi longsor di DAS. Jenis penelitian ini merupakan penelitian deskriptif
kuantitatif dengan prosedur analisis software Geographic Information System (GIS)
berupa analisis tumpang tindih (overlay) faktor—faktor yang berpengaruh terhadap
kejadian tanah longsor seperti Jenis batuan, kemiringan lereng, curah hujan, zona
kerentanan gerakan tanah, tekstur tanah dan tutupan lahan. Berdasarkan hasil
pendugaan kerawanan longsor di DAS Jeneberang, diperoleh tiga tingkat
kerawanan longsor yaitu: Tingkat kerawanan rendah dengan luas 30771 Ha (39%)
memiliki persebaran di Kecamatan Bontomaranu, Palangga, Bajeng Barombong,
Tamalate, dan lain-lain, Tingkat kerawanan sedang dengan luas 38827 Ha (49%)
memiliki persebaran di Kecamatan Parangloe, Manuju, Bungaya, Tinggimoncong
dan Parigi. Dan tingkat kerawanan tinggi dengan luas 9287 Ha (12%) memiliki
persebaran di Kecamatan Tinggimoncong, Parigi dan beberapa daerah di
Kecamatan Parangloe dan Manuju.

Sandri Erfani dkk, (2023). Teknik Overlay dan Scoring GIS untuk Pemetaan
Tingkat Risiko Longsor di Kabupaten Lebak, Banten. Tujuan dari penelitian ini
adalah untuk mengurangi kemungkinan terjadinya bencana dan melindungi
masyarakat dari dampaknya. Analisis overlay dan teknik scoring dan weighting
membantu dalam menentukan tingkat kerentanan longsor dalam pemetaan
kerentanan longsor. Berbagai karakteristik, seperti jenis tanah, geologi, curah hujan,
tutupan lahan, dan gradien lereng, digunakan dalam data penelitian. Data dari
Digital Elevation Model Shuttle Radar Topography Mission (DEM SRTM)
digunakan untuk membuat gradien lereng. Microsoft Office 2019 dan ArcGIS v10.8

adalah teknologi yang digunakan. Dengan intensitas antara 1501-2.000 mm/tahun




dan 2001-2.500 mm/tahun pada musim kemarau, Kabupaten Lebak menerima
banyak curah hujan, terutama pada musim hujan. Batuan yang mudah terkikis dan
aus sangat rentan terhadap longsor. Terutama di daerah dengan jenis tanah licin,
lereng yang curam dapat meningkatkan risiko longsor. Dibandingkan dengan lahan
vang tidak rusak, tutupan lahan yang telah berubah menjadi perkebunan atau kota
biasanya lebih rapuh. Ada tiga jenis longsor di Kabupaten Lebak: rendah, sedang,
dan tinggi. 3.854.,57 hektar tergolong daerah risiko rendah, 160.884 09 ha daerah
risiko sedang, dan 164.993,60 ha daerah risiko tinggi. Kecamatan Wanasalam, yang
meliputi wilayah seluas 2.810,91 hektar, memiliki tingkat kerawanan longsor yang
sebagian besar rendah

Riki dkk, (2022). Kajian Kerawanan Bencana Longsor Berbasis Sistem Informasi
Geografis Sebagai Acuan Mitigasi Bencana di Kecamatan Panti, Kabupaten
Jember. Penelitian ini bertujuan untuk menganalisis potensi bencana alam
khususnya longsor sehingga diharapkan ada persiapan ketika bencana terjadi,
Penelitian ini menggunakan metode penelitian kuantitatif deskriptif dengan metode
survey yang dilakukan untuk mengukur data primer, sampel yang diambil sebanyak
10 titik sampel yang di ambil dengan mempertimbangkan jarak pemukiman dengan
lereng. Analisis data yang di gunakan berupa pembuatan peta dengan metode
weighted overlay dan dipaparkan secara deskriptif. Penyusunan strategi untuk
mengurangi dampak bencana longsor dan melakukan skema-sekema
penanggulangan bencana yang di lakukan menggunakan hasil analisis SWOT yang
di pengaruhi oleh dua factor eksternal dan factor internal. Hasil analisis menunjukan
lereng atas dan lereng tengah dari pembagian tiga zonasi kerawanan memiliki
tingkat kerawanan tinggi hingga sangat tinggi dengan erosi parit yang berada di
lereng atas yang memicu run off danpenjenuhan horizon tanah oleh air. Hasil dari
analisis SWOT yaitu menyiapkan ruang evakuasi bencana yang memadai dan
mudah di akses oleh masyarakat yang berada di lereng bawah dari pembagian
zonasi (SO), pemerintah perlu membuat kebijakan untuk melarang pembangunan
pada kawasan rawan (WO), melakukan edukasi berupa penyuluhan dan pelatihan
kepada masyarakat terkait kebencanaan dan kesadaran akan pentingnya kesiapan
menhadapi bencana untuk memperkuat pengetahuan kebencanaan masyrakat (ST)..

AC Taruna dkk, (2021). Pemetaan Kawasan Potensi Rawan Longsor Berbasis Data




Analisi Sistem Informasi Geografis Di Kota Cimahi. Pemetaan ini bertujuan untuk
Melihat topografi kawasan kota cimahi pinggiran kota cimahi terutama kecamatan
Cimahi utara dan kecamatan Cimahi selatan memiliki tingkat kemiringan lereng
yang cukup berpotensi mengalami bencana alam berupa longsor.Sehingga dalam
hal ini pemetaan kawasan rawan bencana longsor di kota cimahi perlu dilakukan
memanfaatkan sistem informasi geografis dimana berbagai parameter yang
mempengaruhi terjadinya longsor di Kota cimahi perlu dilakukan pengskoran
menjadi beberapa klasifikasi dari klasifikasi sangat rendahrendah.sedang,tinggi
dan sangat tinggi setelah itu dilakukan metode ovelay untuk menggabungkan
berbagai parameter yang ada lalu dilanjutkan dengan tools berupa intersect
sehingga data akan ditumpangtsusunkan dimana data ini menggambarkan tingkat
potensi bencana longsor di Kota cimahi. disimpulkan bahwa daerah yang memiliki
tingkat kerawanan longsor sangat tinggi berada di kecamatan cimahi tengah bagian
barat dimana berbatasan langsung dengan kelurahan cipageran, sedangkan dacrah
yang menunjukan kerawanan longsor tingkat tinggi berada di kecamatan cimahi
selatan tepatnya terkonsentrasi di kelurahan leuwigajah dan sedikit di selatan
cibeber .bagian utara kelurahan setiamanah dan karangmekar.Sedangkan untuk
kerawanan tingkat sedang ada di bagian tengah kelurahan leuwigajah bagian tengah
cipageran,melong, utama, cibereum dan Pasir kaliki.Untuk kerawanan tingkat
rendah dapat ditemui di kelurahan citereup,utama ,baroscigugur tengah dan
Melong.Dan yang terakhir untuk kerawanan longsor tingkat sangat rendah Ada

pada sekitar kelurahan cibabat dan disekitar pusat kota Cimahi.
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BAB 3
LANDASAN TEORI

3.1 Tanah Longsor

Tanah longsor merupakan salah satu jenis gerakan massa tanah atau batuan, ataupun
percampuran  keduanya, menuruni atau keluar lereng akibat terganggunya
kestabilan tanah atau batuan penyusun lereng (Definisi Bencana BNPB, 2023).
Mitigasi bencana longsor di Indonesia mengacu pada UU Penanggulangan
Bencana, melalui tiga tahapan (prabencana, saat bencana, dan pascabencana) yang
dilakukan baik secara struktural maupun nonstruktural. Tahap pertama
(prabencana), kegiatan yang dilakukan adalah pemetaan zona kerentanan dan risiko
bencana gerakan tanah, pemantauan gerakan tanah secara berkesinambungan,
peringatan dini dan penyebaran informasi, penyelidikan gerakan tanah, penguatan
ketahanan masyarakat, dan mitigasi gerakan tanah struktural. Tahap kedua (saat
bencana), kegiatan yang dilakukan adalah tanggap darurat bencana. Dalam tahap
ini dilakukan evaluasi potensi terjadinya gerakan tanah susulan, dampak dan
sebaran gerakan tanah, rekomendasi teknis langkah-langkah penanggulangan serta
pemulihan sarana dan prasarana. Tahap ketiga (pascabencana), kegiatan yang
dilakukan antara lain penentuan daerah relokasi yang aman terhadap bencana,
perbaikan atau rehabilitasi lingkungan daerah bencana, perbaikan atau
pembangunan kembali prasarana dan sarana umum (PVMBG Badan Geologi
Kementerian ESDM)

Menurut (BNPB, 2017) Tanah longsor seringkali dipicu oleh curah hujan tinggi
longsor hingga mengakibatkan bencana khususnya bagi masyarakat yang berada di
posisi lebih rendah. Tanah longsor juga dapat dipicu oleh getaran gempa hingga dan
terjadi selama beberapa hari. Struktur tanah yang labil sangat mudah mengalami
merontokkan struktur tanah di atas. Kemudian menurut Badan Penanggulan
Bencana (BPBD) DI Yogyakarta terdapat beberapa faktor penyebab tanah longsor,
diantaranya :

1. Erosi

Erosi merupakan tergerusnya kaki lereng yang disebabkan oleh aliran air
permukaan atau air hujan, sungai-sungai atau gelombang laut

2. Lereng dari batuan yang lemah




Melemahnya bebatuan dan tanah yang karena saturasi diakibatkan oleh hujan
lebat.

3. Gempa bumi
Gempa bumi menimbulkan getaran, tekanan pada partikel-partikel, dan bidang
lemah pada massa batuan serta tanah.

4. Berat berlebihan

Berat berlebih melebihi kapasitas kekuatan tanah.

3.2 Bahaya Tanah Longsor

Ciri-ciri biologis, klimatologis, geografis, geologis, sosial, ekonomi, politik,
budaya, dan teknis suatu komunitas yang berpotensi membahayakan manusia dan
menyebabkan kerusakan dalam jangka panjang dikenal sebagai bahaya. Salah satu
unsur yang berkontribusi terhadap risiko bencana adalah bahaya. (Jurnal Unud,
2015).

Di Indonesia, tanah longsor dapat dikatakan terjadi setiap tahun, dan beberapa di
antaranya mengakibatkan bencana besar. Setidaknya 103 kali tanah longsor telah
terjadi di provinsi Jawa Barat, Jawa Tengah, Jawa Timur, Sumatera Barat, Sumatera
Utara, Sulawesi Selatan, dan Papua dari tahun 2003-2005. 411 orang tewas, 149
orang luka-luka, 4.608 rumah rusak atau hancur, 751 hektar lahan pertanian
terdampak, dan 920 meter jalan rusak akibat bencana tersebut. (Direktorat Mitigasi
Bencana Geologi dan Vulkanologi, 2007) 62 orang tewas dalam bencana tanah
longsor 26 Desember 2007 di Karanganyar (Naryanto, 2011). 34 rumah tertimbun
dan empat orang tewas dalam tragedi tanah longsor 2011 di Kabupaten Sleman
(Destrianti dan Pamungkas, 2013). Mengingat semua kejadian ini, risiko tanah

longsor di Indonesia benar-benar perlu mendapatkan perhatian (Jurnal Unud, 2015).

3.3 Kemiringan Lereng (Slope)

Menurut Karnawati (2001), kelerengan menjadi faktor yang sangat penting dalam
proses terjadinya tanah longsor. Pembagian zona kerentanan sangat terkait dengan
kondisi kemiringan lereng. Kondisi kemiringan lereng lebih 15° perlu mendapat
perhatian terhadap kemungkinan bencana tanah longsor dan tentunya dengan
mempertimbangkan faktor-faktor lain yang mendukung. Pada dasarnya sebagian

besar wilayah di Indonesia merupakan daerah perbukitan atau pegunungan yang




membentuk lahan miring. Namun tidak selalu lereng atau lahan yang miring
berbakat atau berpotensi longsor. Potensi terjadinya gerakan pada lereng juga
tergantung pada kondisi batuan dan tanah penyusun lerengnya, 17 struktur geologi,

curah hujan, vegetasi penutup, dan penggunaan lahan pada lereng tersebut.

Gambar 3.1 Kemiringan Lereng (Slope)
(Sumber : Google, 2024)
Menurut Anwar et al. (2001), dari berbagai kejadian longsor, dapat diidentifikasi

3 tipologi lereng yang rentan untuk bergerak yaitu:
* Lereng timbunan tanah residual yang dialasi batuan kompak
* Lereng batuan yang berlapis searah lereng topograpi

* Lereng yang tersusun oleh blok-blok batuan.
Menurut (Peraturan Menteri Pekerjaan Umum No .20/PRT/M/2007). Klasifikasi

kelas lereng, terdapat berbagai macam pembagian kelas lereng. Pada umumnya,
pembagian kelas lerengan ini disesuaikan dengan kebutuhan analisa. Pada analisis
aspek fisik wilayah, kelas lereng yang biasa dipakai adalah sebagai berikut:

e Lereng 0% - 8%

e Lereng 8% - 15%

e Lereng 15% - 25%

e Lereng 25% - 45%

e Lereng >45%
34 Fisik
Kerentanan fisik jumlah dari parameter rumah, fasilitas umum (fasum) dan
fasilitas kritis (faskris) yang terdampak suatu bencana. Masing-masing parameter
dianalisis dengan menggunakan metode MCDA sesuai Perka BNPB No. 2 Tahun

2012 untuk memperoleh nilai indeks kerentanan fisik .




3.5 Kerentanan

Kerentanan bencana adalah suatu wilayah yang memiliki kondisi atau karakteristik
geologis, biologis, hidrologis, klimatologis, geografis, sosial, budaya, politik,
ekonomi, dan teknologi yang untuk jangka waktu tertentu tidak dapat atau tidak
mampu mencegah, meredam, mencapai kesiapan, schingga mengurangi

kemampuan untuk menanggapi dampak buruk bahaya tertentu (Septian, 2015).

3.6 Dampak Tanah Longsor

Masyarakat yang terkena dampak dapat mengalami kerugian akibat tanah longsor,
vang menyebabkan penduduk kehilangan tempat tinggal, serta merusak aset
komunal dan mengubah bentuk lahan suatu wilayah. Undang-Undang Nomor 24
Tahun 2007 menyebutkan bahwa bencana dapat mengakibatkan kerugian harta
benda, kerusakan lingkungan, korban jiwa, dan dampak psikologis yang dalam

kondisi tertentu dapat menghambat pertumbuhan nasional.

3.7 Sistem Informasi Geografi (SIG)

Kumpulan perangkat keras, perangkat lunak, data geografis, dan anggota staf yang
terorganisasi digunakan untuk membuat Sistem Informasi Geografis (SIG), alat
pemrosesan basis data berbasis komputer untuk memetakan dan menganalisis
fenomena alam. SIG dibuat untuk mengumpulkan, menyimpan, memperbarui,
memanipulasi, menganalisis, dan menyajikan semua jenis data yang direferensikan
secara geografis secara efisien. Berbagai jenis peta dasar dapat diintegrasikan
menggunakan teknologi SIG. Hal ini sangat membantu saat menganalisis peristiwa
yang terkait dengan bencana alam (Cahyaningrum, 2016).

Sebagian besar data yang ditangani oleh SIG adalah data spasial, atau data
berorientasi geografis. Basis referensinya mencakup sistem koordinat tertentu dan
memiliki dua komponen utama yang membedakannya dari jenis data lainnya:

informasi posisi (spasial) dan informasi deskripsi (atribut) (Cahyaningrum, 2016).
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Gambar 3.2 Analisis Sistem Informasi Geografis

(Sumber : Analsis Penulis, 2024)

38 Metode Tumpang Susun (Overlay)

Dari proses pengumpulan data yang diperoleh berupa peta kemiringan lereng, peta
jenis tanah, peta susunan batuan (geology) dan peta potensi pergerakan tanah
selanjutnya akan di input menggunakan Software QGIS. Proses pemasukan data-
data dilakukan melalui seperangkat komputer dengan Software QGIS dan juga
menggunakan perangkat keras (Hadware) lainnya sebagai pendukung dalam proses
pengolahan data. Berikut proses pengolahan data yang dilakukan :

1. Input

Pada proses input ini data spasial dari setiap parameter tanah longsor akan di

masukkan dalam Software QGIS untuk mulai awal pengolahan data.
2. Proses

Dari setiap data yang sudah melalui proses input, maka akan diproses secara
bertahap pada processing data. Mulai dari pemrosesan data geologi yang didapat
yaitu memuat beragam informasi geologi seperti struktur geologi, kemudian data
kemiringan lereng yang didapat yaitu data sekunder berupa data digital elevasi
model (DEM), data jenis tanah yang diperoleh berupa data sekunder dengan format
tipe data shapefile, dan data potensi pergerakan tanah yang memuat potensi
pergerakan tanah tahunan dalam format data shapefile dan proses data selanjutnya

yaitu data titik sebaran fisik yang berupa titik fasilitas umum dan fasilitas kritis
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pada daerah penelitian. Dari masing-masing data akan dihasilkan peta informasi
setiap parameter dan akan dilakukan overlay untuk dihasilkan peta rawan longsor.
Setelah semua data diproses sesuai dengan nilai acuan dan faktor pendukung lainya,

maka hasil yang sudah ada akan melalui tahap berikutnya
3. Output

Setelah semua data diproses sesuai dengan nilai acuan dan faktor pendukung lainya,

maka hasil yang sudah ada akan melalui tahap berikutnya

Kunci untuk menganalisis fungsi sistem informasi geografis sebenarnya adalah
kemampuan untuk mengintegrasikan data dari dua sumber menggunakan proses
overlay peta. Proses ini dilakukan dengan mengambil dua lapisan peta tematik yang
berbeda dan menutupi area yang sama dan melapisinya satu di atas yang lain untuk
membentuk lapisan baru. Jadi dengan proses overlay ini, akan diperoleh lapisan
data keluaran baru sebagai hasil penggabungan dua atau lebih lapisan data masukan
(Yuslida, 2008).

erdapat perbedaan antara overlay peta dengan data raster dan vektor, sama seperti
prosedur analisis lainnya dalam sistem informasi geografis (SIG). Menggunakan
data vektor untuk overlay peta lebih rumit, mahal, memakan waktu, dan melibatkan
banyak perhitungan. Namun, menggunakan data raster dapat lebih cepat, lebih
efektif, dan lebih mudah (Yuslida, 2008). Overlay vektor tersedia dalam tiga jenis
berbeda, diantaranya ( Yuslida, 2008) :

1. Point-in-Polygon, digunakan untuk menemukan dimana letak suatu titik pada

suatu wilayah. Proses ini dapat digambarkan sebagai berikut :

Gambar 3.3 Proses Overlay Point-In-Polygon
(Sumber : Google, 2024)

2. Line-in-Polygon, digunakan untuk mengetahui letak suatu garis pada suatu

wilayah. Proses ini dapat digambarkan sebagai berikut :
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3. Polygon-on-Polygon, dapat digunakan untuk mengetahui pengaruh suatu

wilayah pada wilayah lain. Ada 3 lapisan data keluaran yang berbeda yang bisa

Gambar 3 4 Proses Overlay Line-In-Polygon

diperoleh, yaitu :

a. Lapisan data keluaran berisi semua Pelygon dari kedua peta masukan. Ini

sesuai dengan operasi Boolean ATAU, atau di dalam proses matematikanya

disebut UNION.

b. Lapisan data keluaran berisi data suatu wilayah yang juga mencakup data
wilayah lain. Wilayah yang mempunyai cakupan lebih luas akan digunakan

sebagai tepi dari peta keluaran. Operasi ini dikenal dengan cookie cutting atau

(Sumber : Google, 2024)

disebut dengan operasi IDENTITAS.

c. Lapisan data keluaran berisi wilayah yang mempertemukan dua kriteria.
Proses ini disebut dengan INTERSECT, atau sama dengan oprasi Boolean

AND dimana peta keluaran yang dihasilkan merupakan perpotongan dari dua

wilayah atau wilayah yang tumpang tindih.

39 Skoring dan Pembobotan

Menurut (Sandry, 2023) proses penentuan skoring dan pembobotan menghasilkan

empat matriks parameter bahaya suatu daerah terhadap tsunami dapat dilihat pada Tabel

3.1 dibawah ini ;

Tabel 3.1 Skor dan Bobot Tiai Parameter

>45% 5 Sangat Miring
25-45% 4 Miring
Kemiringan 15-25% 3 25 Agak Miring
Lereng 8-15% 2 Landai
0-8% 1 Datar
) Vulkanik 3 Rawan
Geologi Sedimen 1 25 Tidak Rawan
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Potensi Tinggi 4 Tinggi

Pergerakan menengah 3 menengah

Tanah Rendah 2 25 Rendah
Sangat Rendah 1 Sangat Rendah

A070-2/3a Acrisols 4 Ti .

(lithic) mggl

Agl5-2/3a Acrisols| . .

Jenis Tanah (Podzolic) 4 25 Tinggi

ems Tanal s 083-2/3c Acrisols| 4 Tingei

(lithic) g8

(Sumber : Sandry, 2023)

Kelas nilai merupakan hasil perhitungan dengan menggunakan rumus perhitungan nilai

bobot total penelitian Sandry (2023) sebagai berikut:
N =% BixSi,dengan:

N adalah nilai bobot total.

Bi = Bobot setiap parameter

Si = Skor setiap kriteria

Perhitungan teknik tumpang susun pada penelitian ini secara matematis dapat dituliskan
sebagai berikut: [(kemiringan Lereng*0,25) + (Geologi*0,25) + (Potensi Gerakan
Tanh*0.25) + (Jenis Tanah*0.25)] (Sandry, 2023). Total bobot dan skor pada keempat
faktor tersebut digunakan untuk menghitung analisis teknik overlapping. Interval kelas
tingkat kerentanan ditentukan dengan nilai N (Efryanti, 2020). Teknik skoring dan
pembobotan diterapkan untuk menentukan nilai bahaya. Hadi dan Damayanti (2017)
menyatakan bahwa variabel N (nilai bobot total) dapat disubstitusikan dengan variabel
X (nilai bahaya) untuk menentukan nilai bahaya.

Interval pada kelas diperoleh dari skor tertinggi di kurangi skor terendah kemudian di
bagi jumlah kelas. Secara matematis interval kelas tingkat bahaya dirumuskan sebagai
berikut (Cahyaningrum,2014) :

Skor Maksimum—Skor Minimum

Interval Kelas =
Jumlah Kelas

3.10 Peta
Peta adalah salah satu jenis sistem informasi. Peta merupakan gambaran normal
terhadap skala dan pada medium bidang datar dari pemilihan penampakan material
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atau abstrak, atau hubungannya terhadap permukaan bumi(Yuslida 2008).

Persyaratan-persyaratan geometrik yang harus dipenuhi oleh suatu peta sehingga

menjadi peta yang ideal adalah (Yuslida, 2008) :

a. Jarak antara titik-titikk yang terletak di atas peta harus sesuai dengan jarak
aslinya di permukaan bumi (dengan memperhatikan faktor skala peta).

b. Luas suatu unsur yang direpresentasikan di atas peta harus sesuai dengan luas
sebenarnya (dengan memperhatikan faktor skala peta).

c. Sudut atau arah suatu garis yang direpresentasikan di atas peta harus sesuai
dengan arah yang sebenarnya (seperti di permukaan bumi).

d. Bentuk suatu unsur yang direpresentasikan di atas peta harus sesuai dengan
bentuk yang sebenarnya (dengan memperhatikan faktor skala peta).

Skala peta adalah perbandingan antara jarak pada peta dan jarak sebenarnya di

bumi. Sebagai gambaran, jika sebuah peta mempunyai skala 1 : 25000 maka jarak

1 em pada peta mewakili 25000 cm atau 0.25 km pada permukaan bumi. Skala pada

peta dihubungkan terhadap tingkat informasi peta ( Yuslida, 2008).
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BAB 4
METODOLOGI PENELITIAN

4.1 Prosedur Penelitian
Pada penelitian peta bahaya dan kerentanan tanah longsor wilayah Kabupaten

Lebak memiliki bagan alir penelitian dapat dilihat pada gambar 4.1 dibawah ini.

Studi Pustaka

4 Pengumpulan Data |

Data Sekunder

a. RBI Kabuparten Lebak

b. DEM STRM

1) Kemiringan Lereng

Kelas lereng <15%
Kelas lereng >45%

. Peta Pegerakan Tanah

d. Peta Geologi

e. Peta Jenis Tanah

i)

2]

I Kelengkapan Data

Analisa Peta Bahaya dan Zona
Kerentanan Tanah Longsor

| Peta Bahaya dan Zona Kerentanan Tanah Longsor |

v

I Kesimpulan dan Saran I

Gambar 4.1 Bagan Alir Penelitian
(Sumber: Analisa penulis, 2024)




Kegiatan penelitian peta bahaya dan kerentanan bencana tanah longsor

menggunakan aplikasi sistem informasi geografis (SIG) di wilayah Kabupaten

Lebak terdiri dari beberapa tahapan metode yang dilakukan oleh penulis, yakni :

a. Tahap Persiapan dilakukan dengan menentukan permasalahan penelitian,
melakukan studi literatur untuk mendapatkan sumber petunjuk serta
pengumpulan data. Data yang dikumpulkan merupakan data sekunder yang

diperoleh dari beberapa situs Instansi terkait

b. Tahap Penelitian dilakukan dengan membuat peta zona bahaya dan kerentanan
tanah longsor dibuat dengan pengelolaan data spasial menggunakan perangkat
lunak sistem informasi geografis. Analisa yang dilakukan adalah analisa overlay,
dimana beberapa peta yang menjadi parameter pemetaan wilayah terhadap
bencana tanah longsor di everlay yang kemudian menghasilkan peta baru hasil

analisia.

4.2 Lokasi Penelitian
Lokasi penelitian ini berada di wilayah Kabupaten Lebak Provinsi Banten dengan

peta lokasi penelitian yang tersaji pada gambar 1.2.

4.3 Alat dan Bahan Penelitian

Alat yang digunakan dalam penelitian Peta Bahaya dan Kerentanan Tanah Longsor
Menggunakan Aplikasi Sistem Informasi Geografis (SIG). (Studi Kasus: Wilayah
Kecamatan Banjarsari Kabupaten Lebak) yang tersaji pada Tabel 4.1 dan Tabel 4.2

dibawah ini.

Tabel 4.1 Alat Yang Digunakan Dalam Penelitian

Laptop Lenovo ideapad 330 Pengolahan data yang digunakan dalam

Windows 11 32-bit Dual pembuatan peta
Core SSD
(Sumber : Analisa penulis, 2024)

Tabel 4.2 Peranikat Lunak Yani Diiunakan Dalam Penelitian

1 Memetakan indeks ba 1 dan kerentanan fisik
QuantumGIS 3.28 tanah longsor di wilayah Kecamatan Banjarsari
2 Microsoft Office Mengolah dan menghasilkan data penelitian

(Sumber : Analisa penulis, 2024)

Data atau bahan yang digunakan dalam penelitian Peta Bahaya dan Kerentanan
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Tanah longsor Menggunakan Aplikasi Sistem Informasi Geografis (SIG). (Studi
Kasus Wilayah Kecamatan Banjarsari Kabupaten Lebak) yang tersaji pada Tabel
4.3 dibawah ini.

Tabel 4.3 Data Yang Digunakan Dalam Penelitian

1 | Batas Administrasi DEM STRM Badan Informasi Geospasial (BIG)
Kabupaten Lebak (http://tanahair .indonesia.go.id)
2 | Kemiringan Lereng RASTER Badan Informasi Geospasial (BIG)

(http://tanahair .indonesia.go.id)

3 | Peta Zona Kerentanan | GIS Vektor
Kementrian ESDM-PVMBG

Pergerakan Tanah (Polygon)
4 | Geologi GIS Vektor i
(Poligon) Kementrian ESDM-PVMBG
5 | Jenis Tanah GIS Vektor
(Poligon) FAQ
6 | Aspek Fisik GIS Point Badan Informasi Geospasial (BIG)
(Titik) (http://tanahair .indonesia.go.id)

BPS Kabupaten Lebak
(Sumber : Analisa penulis, 2024)

4.4 Alur Pembuatan Peta Penelitian
Penelitian akan dilakukan terdiri dari beberapa tahapan alur pembuatan peta

penelitian dilihat pada Gambar 4 4 dibawah ini.

I Peta Administrasi Kabupaten Lebak ]
W
2 v v v
DEM => | Kemiringan Pergerakan ADM kab.
Lereng Tanan Lebak
L ] T | ]
Bahaya Longsor Batas Administrasi

Berdasarkan Batas Adm

Bahaya Longsor
Berdasarkan Batas Adm

Aspek  Fisik

Kerentanan Longsor
Terhadap Aspek  Fisik

Gambar 4.2 Alur Pembuatan Peta Penelitian
(Sumber: Analisa penulis, 2024)
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4.5 Metode Analisa

Metode penelitian bersifat kuantitatif dengan menggunakan metode overlay dengan
pendekatan SIG dan menggunakan standar BNPB untuk bencana longsor. Bahaya
tanah longsor dibuat berdasarkan pengklasifikasian zona kerentanan longsor yang
mengacu pada SNI Penyusunan dan Penentuan Zona Kerentanan Gerakan Tanah
(BSN, 2016). Terdapat banyak parameter yang dipersyaratkan di dalam SNI
tersebut, namun paramater yang digunakan padapenelitian ini merupakan justifikasi
terhadap ketersediaan data spasial dan disesuaikan dengan hasil Ground check di

wilayah penelitian (Heinrick, 2020)

4.6 Jadwal Penelitian
Penelitian ini dilakukan berdasarkan jadwal penelitian yang telah dibuat oleh
penulis sebagai berikut:

Tabel 4.4 Jadwal Penelitian

[ BULAN/2023-2024
No. TAHAPAN [ Agusts [ s | Oktober | Nowember Desember Januari
C[2]afalaf2afafaJa]afal[a[a[ar[a]3]al1]2][3]a

Pengajuan Judul

Pengumpulan Data

Penyusumn Proposal

4 | Seminar Proposal
BULAN/2024
Juni Juli Agustus Septermber Oktaber November
L 2]3[a|n[a]a[a[n]aafau[2][a[4|1[2][3]4]1][2]3]4

n

Pengolahan Data

=

Penyusunan Hasil Penelitian

Seminar Hasil

Sidsng Akhir (Lulus)

o RENCANA
KETERANGAN

(Sumber: Analisa penulis, 2024)
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BAB 5
HASIL PENELITIAN DAN PEMBAHASAN

5.1 Pendahuluan

Secara geografis Kabupaten Lebak terletak antara 6°18'-7°00' Lintang Selatan dan
105°25'-106"30" Bujur Timur, dengan luas wilayah 304.472 Ha (3.044.72 Km?)
yang terdiri dari 28 Kecamatan dengan 340 desa dan 5 kelurahan. Kabupaten Lebak
memiliki batas wilayah administratif sebagai berikut (Badan StatistikaKabupaten
Lebak, 2020) :

a. Sebelah Utara : Kabupaten Serang dan Tangerang
b. Sebelah Selatan  : Samudera Indonesia
c. Sebelah Barat : Kabupaten Pandeglang

d. Sebelah Timur : Kabupaten Bogor dan Kabupaten Sukabumi.

Luas daerah kecamatan Banjarsari tersendiri adalah 15.186 Ha atau sekitae 4.59 %
dari total Luasan Kabupaten Lebak. dan berjaarak 70 Km kepusat Kota/kabupaten
Lebak (Badan Statistika Kabupaten Lebak, 2023).

5.2 Parameter Indeks Bahaya Tanah Longsor
Parameter yang digunakan dalam menentukan indeks bahaya tanah longsor adalah
Batas Administrasi Wilayah, Data DEM untuk Kemiringan Lereng (slope), Data

Geologi, Data Jenis Tanah dan Pergerakan Tanah (Runout).

5.2.1 Kemiringan Lereng (Slope)
Tanah Longsor memiliki sifat merusak maka dalam upaya menegetahui tingkat

indeks bahayanya batas wilayah tinjauan sangat diperlukan.

Kemiringan lereng dibuat dari peta RBI Kabupaten Lebak diambil dari sumber
Tanah Air Indonesia (Ina Geospasial), menggunakan Sistem Informasi Geografis
(SIG). Menurut (Peraturan Menteri Pekerjaan Umum No.20/PRT/M/2007).
Klasifikasi kelas lereng, terdapat berbagai macam pembagian kelas lereng. Pada
umumnya, pembagian kelas lerengan ini disesuaikan dengan kebutuhan analisa

kemudian di analisa dapat dilihat pada gambar 5.1 dibawah ini.
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Gambar 5.1 Peta Kemiringan Lereng Kecamatan Banjarsari

(Sumber : Analisa penulis, 2024)

Pada penelitian tingkat bahaya Tanah longsor ini kelas kemiringan lereng dibagi
menjadi 5 kelas bahaya yaitu kelas (1) datar (0-8% ), kelas (2) landai (8-15 %),
kelas (3) agak curam (15-25%), kelas (4) curam (25-45%) dan kelas (5) sangat

curam (>45%). Parameter kemiringan lereng untuk menentukan nilai bobot

masing-masing kelas dimasukan skor (1-5) dan bobot (25%) dengan cara open

atributte table pada

aplikasi Quantun GiS, kemudian masing-masing skor

dikalikan dengan bobot mengacu pada tabel 3.1 (BNPB.2020), sehingga

menghasilkan nilai bobot dan persentase (%) dapat dilihat pada tabel 5.1 dibawah

ini.

Tabel 5.1 Kemiringan Lereng Kecamatan Banjarsari

KEMIRINGAN LERENG LUAS
SO Keterangan Skor Bobot ]1:0 i{:ﬁt Ha %
1 0-8% 1 0.25 0.25 467561 33%
2 8§—-15% 2 0.25 0.5 5508.12 37%
3 15-25% 3 0.25 0.75 310654 23%
4 25-45% 4 0.25 1 502.43 6%
5 >45% 5 0.25 1.25 T45 1%
TOTAL 14166,27 100 %

(Sumber : Analisa penulis, 2024)

Berdasarkan (Gambar 5.1), wilayah Kecamatan Banjarsari Kabupaten Lebak

memiliki kemiringan lereng yang berbeda-beda. Diindikasikan bahwa daerah yang

berwarna hijau tua merupakan permukaan yang datar, hijau muda merupakan
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permukaan yang memiliki kemiringan lereng landai, hijau lumut merupakan
permukaan yang memiliki kemiringan lereng sedang, kuning semu putih
merupakan permukaan yang memiliki kemiringan kereng curam, dan berwarna

jingga merupakan permukaan yang memiliki kemiringan lereng sangat curam.

5.2.2 Geologi (Batuan)

Peraturan Menteri Pertanian (2006) menjelaskan bahwa sifat dari bahan induk tanah
ditentukan oleh batuan dan komposisi mineral yang terkandung di dalamnya. Di
daerah pegunungan, bahan induk tanah didominasi oleh batuan kokoh dari batuan
volkanik, sedimen, dan metamorfik. Tanah yang berbentuk dari batuan sedimen,
terutama batu liat, batu liat berkapur atau marl dan batu kapur, relatif peka tehadap
erosi dan longsor. Data Poligon (vektor) geologi kabupaten lebak pada penelitian
ini dianlisis menjadi peta geologi kecamatan banjarsari dapat dilihat pada gambar

5.2 dibawah ini.

1]
PETA GEDLOGI KECAMATAN BANARSARI
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Gambar 5.2 Peta Geologi Kecamatan Banjarsari
(Sumber : Analisa penulis, 2024)
Pada penelitian indeks bahaya tanah longsor ini geologi dibagi menjadi 3 kelas
bahaya yaitu kepekaan terhadap longor rendah (batuan vulkanik), Kepekaan
terhadap longsosr sedang (batuan metamorf), dan Kepekaan terhadap longsor tinggi

(batuan sedimen). Parameter geologi (batuan) untuk menentukan nilai bobot pada

32




kelas dimasukan skor (1-3) dan bobot (25%) dengan cara open atributte table pada
aplikasi Quantum GIS, kemudian masing-masing skor dikalikan dengan bobot
mengacu pada tabel 3.1 (BNPB,2020), sehingga menghasilkan nilai bobot dan
memiliki luasan (Ha) dapat dilihat pada (Tabel 5.2).

Tabel 5.2 Tabel Jenis Batuan (Geologi) Kecamatan Banjarsari

JENIS BATUAN LUAS
NO Nilai
Keterangan Skor | Bobot Bobot Ha %
1 Batuan Vulkanik 1 0.25 0.25 7554,54 53%
2 Batuan Sedimen 3 0.25 0.75 6587.74 47%
TOTAL 1416627 100%

(Sumber : Analisa penulis, 2024)
Berdasarkan (Gambar 5.2)daerah kecamatan banjarsari terdiri dari berbagai jenis
geologi (susunan batuan) yang didominasi oleh jenis susunan batuan sedimen 53%
dan vulkanik 47% yang dimana memiliki tingkat kepekaanya masing masing

terhadap kerentanan tanah longsor.

5.2.3 Jenis Tanah

Jenis Tanah merupakan salah satu parameter penyusun bahaya tanah longsor. Data
poligon dari data jenis tanah FAO kemudian dilakukan analisis dapat dilihat pada
gambar 5.3 dibawah ini.
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Gambar 5.3 Jenis Tanah (Soil Map)
(Sumber : Analisa penulis, 2024)

Pada penelitian tingkat bahaya tanah longsor kecamatan banjarsari didominasi jenis tanah
acrisols atau pada aturan pusat penelitaan tanah indonesia jenis ini bernama podsolik

merah kuning. Parameter Jenis tanah (seil map) untuk menentukan nilai bobot pada
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kelasnya dengan bobot (25%) dengan cara open atributte table pada aplikasi QuantumGlS

kemudian masing-masing skornya dikalikan dengan bobot mengacu pada tabel 5.3

(Sandri,2023), sehingga menghasilkan nilai bobot dan memiliki luasan (Ha) dapat dilihat
pada tabel 5.3 dibawah ini.

Tabel 5.3 Tabel Jenis Tanah Kecamatan Banjarsari

JENIS TANAH LUAS
NO Nilai
Keterangan | Skor Bobot Bobot Ha %
1 A070-2/3a 4 025 1 12919,55 91%
Acrisols (lithic)
2 Agl5-2/3a 4 0.25 1 205,04 2%
Acrisols
(Podzolic)
3 A083-2/3¢ 4 0.25 1 104268 %
Acrisols (lithic)
TOTAL 14166.27 100%

(Sumber : Analisa penulis, 2024)

Berdasarkan (Gambar 5.3), wilayah Kecamatan Banjarsari Kabupaten Lebak

didominasi jenis tanah podsolik merah kuning dan Acrisols yang berbeda tipe.

Dapat dilihat jenis tanah acrisols yang mendominasi yaitu tipe Ao atau Acrisol

lithic.

5.2.4 Potensi Pergerakan Tanah (Runouf)

Potensi gerakan tanah (Runout) dibuat dari  Kabupaten Lebak diambil dari

sumber dari kementrian ESDM dan lalu dilakukan analisa dengan menggunakan

Sistem Informasi Geografis (S1G)gambar 5.4 dibawah ini

PETA PPOTENSI GERAKAN TANAH KECAMATAN BANJARSARI
KABUPATEN LEBAK
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Gambar 5 4 Peta Potensi Gerakan Tanah

(Sumber : Analisa penulis, 2024)
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Pada penelitian tingkat bahaya tanah longsor ini parameter potensi pergerakan
tanah dibagi menjadi 4 kelas bahaya yaitu 1 (sangat rendah ), 2 (rendah), 3
(menengah), dan 4 (tinggi). Parameter pergerakan tanah (runout) untuk
menentukan nilai bobot pada kelas ketinggian dimasukan skor (1- 4) dan bobot
(25%) dengan cara open atributte table pada aplikasi QuantumGlS kemudian
masing-masing skor dikalikan dengan bobot mengacu pada tabel 3.1 (Pvmbg
KemenESDM,2016), sehingga menghasilkan nilai bobot dan memiliki luasan (Ha)
dapat dilihat pada tabel 5.4 dibawah ini.

Tabel 5.4 Tabel Zona Potensi Pergerakan Tanah Kecamatan Banjarsari

POTENSI PEGERAKAN TANAH LUAS
NO Nilai

Keterangan Skor Bobot Bobot Ha %

1 Sangat Rendah 1 0,25 0,25 531,27 3%
2 | Rendah 2 025 0.50 745855 53%
3 Menengah 3 0,25 0,75 [ 4675,12 34%
4 | Tinggi 4 0.25 1 1528,11 10%
TOTAL 1416626 | 100%

(Sumber : Analisa penulis, 2024)

Berdasarkan (Gambar 5.3), wilayah Kecamatan Banjarsari Kabupaten Lebak
memiliki potensi pergerakan tanah sangat rendah, rendah, menengah, dan tinggi
dengan skor kelas dan masing masing bobot yang berbeda sesuai dengan yang

ditampilkan pada (Tabel 5.4)
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5.2.5 Bahaya Tanah Longsor

| Kabupaten Lebak |

v

I Wilayah Bagian Kecamatan Banjarsari I

v

!

v

DEM/RBI FAO ESDM
Kemiringan Jenis Tanah Geologi Pergerakan
Tanah

Lereng

|

v

Longsor

Peta Bahaya

¥

Batas Desa

v

Peta Bahaya Longsor
Berdasarkan Desa

Gambar 5.5 Flow Chart Pembuatan Peta indeks Bahaya Tanah Longsor
(Sumber : Analisa penulis, 2024)

Dari parameter-parameter diatas maka didapat peta bahaya tanah longsor, pada
masing- masing parameter seperti kemiringan lereng, zona pergerakan tanah, jenis
tanah, dan jenis batuan keempat parameter tersebut yang sudah dimasukan masing-
masing skor dan bobot mengacu pada tabel 3.1 (Sandry 2023), kemudian mengalikan
skor dan bobot menghasilkan nilai bobot dengan cara open attribute table kemudian
di overlay atau digabungkan menggunakan geoprocesing tools, selanjutnya keempat
parameter nilai bobot dijumlahkan menghasilkan nilai total, selanjutnya pada nilai total
menentukan tingkat bahaya tanah longsor dengan cara menghitung kelas interval dapat
dilihat pada tabel lampiran. Nilai total minimum adalah 1.75 dan nilai maksimum

adalah 3.25 sedangkan jumlah kelas adalah 3 dapat dimasukan pada rumus dibawah

ini.

36




Skor Maksimum—Skor Minimum

Interval Kelas =
Jumlah Kelas

Maka didapat kelas Interval 0.50 kemudian selanjutnya dikelompokan berdasarkan
tingkat bahaya tanah longsor dapat dilihat pada tabel 5.5 dan menghasilkan peta
bahaya tanah longsor dapat dilihat pada gambar 5.6 dibawah ini.

Tabel 5.5 Tingkat Bahaya Tanah Longsor Kecamatana Banjarsari

INDEKS BAHAYA TANAH LONGSOR LUAS
NO Tingkat Bahaya Nilai Bahaya Ha %
Tanah Longsor Tanah Longsor
1 Rendah 175-225 5288.18 37
2 Sedang 225-275 806833 57
3 | Tinggi 275-325 80951 6
TOTAL 1416627 100

(Sumber : Analisa penulis, 2024)

Berdasarkan (Tabel 5.5) indeks bahaya tanah longsor di kecamatan banjarsari
terdapat 3 kategori bahaya diantaranya indek bahaya rendah (37%), indek bahaya
sedang (57%), dan indeks bahaya tinggi (7%) dengan sebaran luasan masing masing

indeks bahaya berdasarkan batas desa.
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Gambar 5.6 Peta Bahaya Tanah Longsor
(Sumber : Analisa penulis, 2024)
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Berdasarkan peta bahaya tanah longsor di wilayah kecamatan banjarsari Kabupaten
Lebak mengasilkan tingkat bahaya yaitu tinggi berwarna merah, sedang berwarna
kuning semu (cream), rendah berwarna hijau. Untuk memperjelas peta bahaya tanah
longsor dimasukan peta batas desa di wilayah Kecamatan banjarsari Kabupaten Lebak,
peta desa diambil dari peta Rupa Bumi Indonesia (RBI) yang bersumber dari website

resmi Indo Geospasial dapat dilihat pada Gambar 5.7 dibawah ini.
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Gambar 5.7 Peta Batas Desa Kecamatan Banjarsari Kabupaten Lebak
(Sumber : Analisa penulis, 2024)

Berdasarkan Gambar 5.7 diatas dapat diketahui bahwa wilayah kecamatan banjarsari

Kabupaten Lebak yaang terdiri 20 desa untuk memperjelas nama desa dan masing-
masing luasan dapat dilihat pada tabel 5.6, selanjutnya peta desa dihubungkan dengan
peta bahaya tanah longsor sehingga bisa dilihat pada Gambar 5.8 dibawah ini.

Tabel 5.6 Batas Desa

LUAS
NO NAMA DESA Ha %
1 Bendungan 621922 4%
2 | Bojong Juruh 122895 8%
3 | Cilegongilir 758,190 5%
4 | Ciruji 493 325 3%
5 | Cisampih 905,173 6%
6 Gunungsari 629,766 4%




7 | Jalupang Girang 551,850 4%
8 | Cibaturkesik 241944 2%
9 | Cidahu 52944 3%
10 | Kaduhauk 306,744 2%
11 | Kerta 133329 9%
12 | Kertaraharja 139145 Q%
13 | Kertarahayu 80993 5%
14 | Keusik 556,10 4%
15 | Kumpay 68644 5%
16 | Leban Jaya 346,72 2%
17 | Lebak Keusik 1000.28 7%
18 | Leuwi Piuh 1476.61 10%
19 | Tamansari 754.71 5%
20 | Umbul Jaya 501.60 3%
Total 1416627 | 100%

Untuk mengetahui tingkat bahaya berdasarkan batas desa dengan cara intersect pada
peta bahaya tanah longsor dan peta batas desa pada dapat diketahui tingkat bahaya
tanah longsor berdasarkan masing-masing desa di wilayah kecamatan banjarsari
Kabupaten Lebak dapat dilihat pada (Gambar 5.8) dan memiliki luas tingkat bahaya
tanah longsor masing-masing desa terdiri dari 20 desa dapat dilihat pada (Tabel 5.11)

dibawah ini.

(Sumber : Analisa penulis, 2024)
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Gambar 5.8 Peta indeks Bahaya Tanah Longsor Terhadap Batas Desa
(Sumber : Analisa penulis, 2024)
Tabel 5.7 Tingkat Bahaya Tanah Longsor Berdasarkan Desa
LUAS TINGAT BAHAYA (Ha)
Nama
Desa Ha % Rendah Sedang Tinggi
1 Bendungan 621,922 4% 187.63 403 45 18.23
2 | Bojong Juruh 122895 8% 344.12 845.86 23.04
3 | Cilegongilir 758,190 5% 0 661.97 90.08
4 | Ciruji 493,325 3% 128.36 321.63 21.04
5 | Cisampih 905,173 6% 2.17 800.83 85.71
6 | Gunungsari 629,766 4% 53.07 51059 43.10
7 | Jalupang 551,850 4% 17.57 508.92 14.54
Girang
8 | Cibaturkesik 241,944 2% 1.39 223.23 6.32
9 | Cidahu 52944 3% 135.61 359 5] 26.17
10 | Kaduhauk 306,744 2% 67.10 226.36) 1.91
11 | Kerta 1333.29 9% 641.03 649.7 7.54
12 | Kertaraharja 139145 9% 456.02 883.18 22.68
13 | Kertarahayu 809,93 5% 96.34 683.51 18.97
14 | Keusik 556,10 4% 88.12 426.54 15.03
15 | Kumpay 686,44 5% 257.60 380.85 18.67
16 | Leban Jaya 346,72 2% 0 285.98 60.10
17 [Lebak Keusik 1000,28 7% 323.80 641.35 16.13
18 | Leuwi Piuh 1476,61 10% 391.10 924.10 128.28
19 | Tamansari 754.72 5% 216.34 518.85 19.53
20 | Umbul Jaya 501,60 3% 232.77 265.70 0.09
Total 14166,27 100 5288.18 8068.33 809.51

(Sumber : Analisa penulis, 2024)
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Kecamatan Banjarsari terdiri dari 20 desa yang memiliki beberapa luasan (Ha) tingkat
bahaya tanah Longsor dapat dilihat pada (Tabel 5.7)), pada desa di Kecamatan
Banjarsari tidak semua desa memiliki tingkat bahaya tanah longsor tinggi - rendah.
Berdasarkan Peta Bahaya Tanah Longsor desa yang tidak memiliki tingkat bahaya
tanah longsor sangat tinggi - rendah (Leban Jaya dan Cilegon Gilir), serta desa yang
memiliki semua potensi tinggi - rendah (Bendungan, Bojong Juruh, Ciruji, Cisampih,
Gungung Sari, Jalupang Giring, Cibaturkeusik, Cidahu, Kaduhaauk, Kerta, Kerta,
Kertaraharja, Kertarahayu, Keusik, Kumpay, Lebak Keusik, Leuwiipuh, Tamansari,
dan Umbul Jaya).

5.3 Kerentanan Fisik Tanah Longsor

Pada penelitian ini data pendukung yang digunakan untuk menentukan tingkat
kerentanan fisik tanah longsor wilayah kecamatan banjarsari tersebut diambil dari peta
Rupa Bumi Indonesia (RBI) yang bersumber dari website resmi Sistem Informasi
Geografis (SIG) yaitu Tanah Air Indonesia. Selanjutnya untuk mempermudah

penelitian ini dengan cara membuat Flow Chart pada gambar 5.9 dibawah ini

Peta Indeks Bahaya Longsor Berdasarkan Batas Desa

v

Fisik Daerah

¥

Kerentanan Tanah
Longsor Terhadap Fisik

¥

Zona Kerentanan Fisik Tanah
Longsor Kecamatan Banjarsari
Lebak

Gambar 5.9 Bagan Alir Penentuan Peta Kerentanan Fisik Tanah Longsor
(Sumber : Analisa penulis, 2024)
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5.3.1 Kerentanan Tanah Longsor Terhadap Fisik

Kerentana Fisik mengacu pada Kondisi infrastruktur yang berpotensi merugi (UN-
ISDR) Pada penelitian ini menggunakan data jumlah rumah (permukiman), fasilitas
umum, dan fasilitas kritis wilayah Kecamatan Banjarsari Kabupaten Lebak dari data
sekunder yang didapat dari Kabupaten Lebak dalam angka Badan Pusat Stastistik
(BPS) dan Peta Rupa Bumi Indonesia BIG (Indonesia Geospa, kemudian data dianalisi

dan mendapatkan peta kerentanan Fisik tanah longsor disajikan pada gambar 5.11

dibawah.
PETA FISIK
KECAMATAN BANJARSARI =
KABUPATEN LEBAK @
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Gambar 5.10 Peta Fisik Kecamatan Banjarsari
(Sumber : Analisa penulis, 2024)

Berdasarkan peta fisik kecamatan Gambar 5.10 diatas bahwa di wilayah
kecamatan banjarsari Kabupaten Lebak memiliki sebaran (Titik) Fisik dapat dilihat
padaTabel 5.8 dibawah ini

Tabel 5.8 Daftar Aspek Fisik Di Kecamatan Banjarsari

FISTK
No Jenis FisiK Jumlah
1 | Permukiman (rumah) 12226
2 | Sekolah 50
3 | Mesjid 12
4 | Pasar 3
5 | Bangunan 424




\ 6 j PUSKESMAS | 2 |
| 7 | Rumah Sakit | o |
(Sumber : Analisa penulis, 2024)

Kerentanan fisik tanah longsor kecamatan dihasilkan dari peta bahaya tanah longsor
berdasarkan batas desa dan peta titik fisik kecamatan, kemudian kedua peta tersebut di
intersect sehingga dapat diperoleh tingkat kerentanan terhadap fisik dapat dilihat pada

gambar 5.11 dibawabh ini.
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Gambar 5.11 Peta Kerentanan Fisik Tanah Longsor
(Sumber : Analisa penulis, 2024)

Berdasasrkan (Gambar 5.11) dapat dilihat sebararan aspek fisik di kecamatan banjarsari
yang berupa titik (peint) diantaranya pemukiman, puskesmas, pasar, sarana ibadah/mesjid,
bangunan, dan sekolah.

53.2 Zona Kerentanan Fisik Tanah Longsor

Berdasarkan kerentanan tanah longsor dihasilkan dari peta kerentanan tanah longsor

terhadap fisik kecamtan gambar 5.10 dan peta kerentanan tanah longsor terhadap aspek

fisik gambar 5.11, kemudian kedua peta tersebut di intersect sehingga dapat diperoleh

tingkat kerentanan tanah longsor dapat dilihat pada gambar 5.12 dibawah ini.
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Gambar 5.12 Peta Kerentanan Fisik Tanah Longsor
(Sumber : Analisa penulis, 2024)
Pada zona kerentanan fisik tanah longsor berdasarkan dari tingkat kerentanan

tanah longsor diwilayah kecamatan banjarsari Kabupaten Lebak yaitu (tinggi,

sedang, dan rendah).

Tabel 5.9 Kerentanan Fisik Tanah Longsor Kecamatan Banjarsari

KERENTANAN TANAH LONGSOR
TERHADAP FISIK
KECAMATAN TITIK TINGAT BAHAYA
BANJARSARI
No | Fisik Kecamatan Jumlah Tinggi | Sedang | Rendah
1 |Permukiman (rumah) 12.226 558 7781 3.887
2 |Sekolah 50 0 30 20
3 Mesjid 19 0 10 9
4 |Pasar 3 0 2 1
5 |Bangunan 424 20 316 88
6 |PUSKESMAS 2 0 0 2
7 |Rumah Sakit 0 0 0 0
TOTAL 12.724 578 8.139 4.007

(Sumber : Analisa penulis, 2024)
Berdasarkan hasil penelitian peta kerentanan fisik tanah longsor terdapat 20 desa
masing-masing memiliki kondisi fisik yang berbeda-beda. Terdapat beberapa fisik

yang tidak terkena potensi kerentanan dibeberapa desa yaitu Puskesmas, Sekolah,




Pasar, dan Pusat kecamatan.
Berdasarkan peta kerentanan fisik tanah longsor di wilayah kecamatan banjarsari
Kabupaten Lebak dapat dikelompokan berdasarkan desa di Kecamatan banjarsari

dapat dilihat pada tabel kerentanan tanah longsor terhadap fisik kecamatan (Tabel 5.9).
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Desa Bendungan memiliki 6 dari 7 fisik dengan luas 621,922 ha, pada tingkat
kerentanan tanah longsor tinggi (pemukiman/rumah), pada tingkat kerentanan sedang
(pemukiman, sekolah, bangunan), pada tingkat kerantanan rendah (pemukiman/rumah,

mesjid, dan bangunan).

Desa Bojongjuruh memiliki 3 dari 7 fisik dengan luas 122895 ha, pada tingkat
kerentanan tanah longsor tinggi (bangunan), pada tingkat kerentanan sedang
(pemukiman/rumah, sekolah dan bangunan). pada tingkat kerantanan rendah
(pemukiman/rumah, sekolah, dan bangunan).

Desa Cibaturkeusik memiliki 4 dari 7 fisik dengan luas 241944 ha, pada tingkat
kerentanan tanah longsor tinggi (tidak ada), pada tingkat kerentanan sedang
(pemukiman/rumah, mesjid, sekolah, dan bangunan), pada tingkat kerantanan rendah
(tidak ada).

Desa Cidahu memiliki 6 dari 7 fisik dengan luas 529 44 ha, pada tingkat kerentanan
tanah longsor tinggi (pemukiman/rumah dan bangunan), pada tingkat kerentanan
sedang (pemukiman/rumah, mesjid, pasar, dan bangunan), pada tingkat kerantanan
rendah (pemukiman/rumah, puskesmas, mesjid, sekolah, dan bangunan).

Desa Cilegonilir memiliki 4 dari 7 fisik dengan luas 758,190 ha, pada tingkat
kerentanan tanah longsor tinggi (bangunan), pada tingkat kerentanan sedang
(pemukiman/rumah, mesjid, sekolah, dan bangunan), pada tingkat kerantanan rendah
(tidak ada).

Desa Ciruji memiliki 3 dari 7 fisik dengan luas 493,325 ha, pada tingkat kerentanan
tanah longsor tinggi (pemukiman.rumah dan bangunan), pada tingkat kerentanan
sedang (pemukiman/rumah, mesjid.dan bangunan), pada tingkat kerantanan rendah

(pemukiman/rumah).

Desa Cisampih memiliki 4 dari 7 fisik dengan luas 905,173 ha, pada tingkat
kerentanan tanah longsor tinggi (pemukiman/rumah dan bangunan), pada tingkat
kerentanan sedang (pemukiman/rumah, mesjid, sekolah, dan bangunan), pada tingkat
kerantanan rendah (tidak).

Desa Gunungsari memiliki 4 dari 7 fisik dengan luas 629,766 ha, pada tingkat

kerentanan tanah longsor tinggi (tidak ada), pada tingkat kerentanan sedang
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(pemukiman/rumah, mesjid, sekolah, dan bangunan), pada tingkat kerantanan rendah
(pemukiman/rumah, mesjid, dan bangunan).

Desa jalupang girang memiliki 3 dari 7 fisik dengan luas 551,850 ha, pada tingkat
kerentanan tanah longsor tinggi (bangunan), pada tingkat kerentanan sedang
(pemukiman/rumah, sckolah, dan bangunan), pada tingkat kerantanan rendah
(bangunan).

Desa kadu hauk girang memiliki 3 dari 7 fisik dengan luas 306,744 ha, pada tingkat
kerentanan tanah longsor tinggi (tidak ada), pada tingkat kerentanan sedang
(pemukiman/rumah, sekolah, dan bangunan), pada tingkat kerantanan rendah

(pemukiman/rumah dan bangunan).

Desa kerta memiliki 5 dari 7 fisik dengan luas 133329 ha, pada tingkat kerentanan
tanah longsor tinggi (tidak ada), pada tingkat kerentanan sedang (pasar, sekolah, dan
bangunan), pada tingkat kerantanan rendah (pemukiman/rumah, puskesmas, sekolah
dan bangunan)..

Desa kertaraharja memiliki 3 dari 7 fisik dengan luas 139145 ha, pada tingkat
kerentanan tanah longsor tinggi (tidak ada), pada tingkat kerentanan sedang
(pemukiman/rumah, sekolah, dan bangunan), pada tingkat kerantanan rendah
(pemukiman/rumah, sekolah, dan bangunan).

Desa kertarahayu memiliki 3 dari 7 fisik dengan luas 80993 ha. pada tingkat
kerentanan tanah longsor tinggi (bangunan), pada tingkat kerentanan sedang
(bangunan), pada tingkat kerantanan rendah (pemukiman/rumah, mesjid, dan
bangunan).

Desa keusik memiliki 4 dari 7 fisik dengan luas 556,10 ha, pada tingkat kerentanan
tanah longsor tinggi (pemukiman/rumah), pada tingkat kerentanan sedang
(pemukiman/rumah, sekolah, dan bangunan), pada tingkat kerantanan rendah
(pemukiman/rumah, sekolah, dan bangunan).

Desa kumpay memiliki 4 dari 7 fisik dengan luas 686 44 ha, pada tingkat kerentanan
tanah longsor tinggi (tidak ada), pada tingkat kerentanan sedang (pemukiman/rumah,
sekolah, dan bangunan), pada tingkat kerantanan rendah (pemukiman/rumah, mesjid,
sekolah, dan bangunan).

Desa lebanjaya memiliki 4 dari 7 fisik dengan luas 346,72 ha, pada tingkat kerentanan
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tanah longsor tinggi (pemukiman/rumah), pada tingkat kerentanan sedang
(pemukiman/rumah, mesjid, sekolah, dan bangunan), pada tingkat kerantanan rendah
(tidak ada).

Desa lebak keusik memiliki 4 dari 7 fisik dengan luas 1000,28 ha, pada tingkat
kerentanan tanah longsor tinggi (tidak ada), pada tingkat kerentanan sedang
(pemukiman/rumah, mesjid, sekolah, dan bangunan), pada tingkat kerantanan rendah
(pemukiman/rumah dan bangunan).

Desa leuwi ipuh memiliki 4 dari 7 fisik dengan luas 1476,61 ha, pada tingkat
kerentanan tanah longsor tinggi (pemukiman/rumah dan bangunan), pada tingkat
kerentanan sedang (pemukiman/rumah dan bangunan), pada tingkat kerantanan rendah
(pemukiman/rumah, mesjid, sekolah dan bangunan).

Desa tamansari memiliki 4 dari 7 fisik dengan luas 754.71 ha, pada tingkat kerentanan
tanah longsor tinggi (bangunan), pada tingkat kerentanan sedang (pemukiman/rumah,
sekolah dan bangunan), pada tingkat kerantanan rendah (pemukiman/rumah, pasar, dan
bangunan).

Desa umbuljaya memiliki 4 dari 7 fisik dengan luas 501,60 ha, pada tingkat kerentanan
tanah longsor tinggi (tidak ada), pada tingkat kerentanan sedang (pemukiman/rumah
dan bangunan), pada tingkat kerantanan rendah (pemukiman/rumah, mesjid, sekolah

dan bangunan).
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BAB 6
KESIMPULAN DAN SARAN

6.1 Kesimpulan

Berdasarkan hasil dan pembahasan peta indeks bahaya dan kerentanan fisik tanah longsor

menggunakan informasi sistem informasi geografis (SIG) di kecamatan banjarsai Kabupaten

Lebak

a.

Peta indeks bahaya tanah longsor diwilayah Kecamatan Banjarsari Kabupaten Lebak
dari hasil penelitian ditunjukan pada (Gambar 5.8). Kecamatan Banjarsari terdiri dari 3
longsoran yaitu rendah, sedang dan tinggi. Luas daerah risiko rendah 5288.18 ha, luas
daerah risiko sedang 8068.33 ha, dan luas daerah risiko tinggi 809.51 ha. Daerah
kerawanan longsor dengan dominasi tingkat kerawanan longsor rendah ditunjukkan di
Desa kerta luas 641.03 ha atau 17%, sedang terdapat di Desa Leuwi Ipuh 924.10 ha atau
8%, dan tinggi ditunjukkan di Desa Leuwi Ipuh luas 128.28 ha atau 20%;

. Peta kerentanan fisik tanah longsor di Kecamatan Banjarsari Kabupaten Lebak dari hasil

penelitian ditunjukkan pada (Gambar 5.12). Berdasarkan aspek fisik Kecamatan
Banjarsari Kabupaten Lebak dengan jumlah total 12.724 titik yang memiliki tingkat
kerentanan terbesar diantaranya : pada kategori rendah yaitu pemukiman/rumah dengan
jumlah 3887 titik atau 97 % dari 4.007 titik, kategori sedang pada pemukiman/rumah
dengan jumlah 7.781 titik atau 95% dari 8.139 titik, dan pada tinggi yaitu
pemukiman/rumah dengan jumlah 558 titik atau 96% dari 578 titik.

6.2 Saran

a.

Penelitian dapat dilanjutkan dengan penelitian mitigasi dan resiko tanah longsor

sehingga dampak lanjutan dapat diprediksi dan dikurangi;

. Perlu adanya penelitian sejenis dengan penggunaan data atau parameter yang lebih

akurat, aktual, dan lengkap (data curah hujan, dll) serta tetap mengacu pada (BNPB
2019) dan (Badan Nasional Penanggulangan Bencana 2012) sehingga penelitian bisa
lebih baik;

Selanjutnya pemerintah bisa menentukan penggunaan jalur evakuasi, papan informasi,
peringatan dini dan penyuluhuan serta melakukan monitoring di kawasan yang
berpotensi longsor untuk mengantisipasi semua resiko dari terjadinya bencana tanah

longsor.
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Tabel 5.1 Kemiringan Lereng Kecamatan Banjarsari

KEMIRINGAN LERENG LUAS
NO Nilai

Keterangan | Skor Bobot Bobot Ha %

1 0-8% 1 0.25 0.25 5008.61 33%
2 8—15% 2 0.25 0.5 5841.12 37%
3 15-25% 3 0.25 0.75 343954 23%

4 25-45% 4 0.25 1 50243 6%

5 >45 % 5 0.25 1.25 745 1%
TOTAL 1514227 100 %

(Sumber : Analisa penulis, 2024)

Tabel 5.2 Tabel Jenis Batuan (Geologi) Kecamatan Banjarsari

JENIS BATUAN LUAS
NO Nilai
Keterangan Skor | Bobot Bobot Ha %
1 Batuan Vulkanik 1 0.25 0.25 8054 54 53%
2 Batuan Sedimen 3 0.25 0.75 708774 47%
TOTAL 15142,27 100%
(Sumber : Analisa penulis, 2024)
Tabel 5.3 Tabel Jenis Tanah Kecamatan Banjarsari
JENIS TANAH LUAS
NO Nilai
Keterangan | Skor Bobot Bobot Ha %
1 A070-2/3a 4 025 1 1389455 91%
Acrisols (lithic)
2 Agl5-2/3a 4 025 1 205,04 2%
Acrisols
(Podzolic)
3 A083-2/3¢ 4 025 1 1042 68 7%
Acrisols (lithic)
TOTAL 1514226 100%

(Sumber : Analisa penulis, 2024)

Tabel 5.4 Tabel Zona Potensi Pergerakan Tanah Kecamatan

Banjarsari
POTENSI PEGERAKAN TANAH LUAS

S Keterangan Skor Bobot ]:) i{:)jt Ha %
1 Sangat Rendah 1 025 0,25 531,27 3%
2 | Rendah 2 025 0,50 7958,55 | 53%
3 Menengah 3 025 0,75 5175,12 34%
4 | Tinggi 4 025 1 1528,11 10%
TOTAL 1514226 | 100%

(Sumber : Analisa penulis, 2024)




Tabel 5.5 Tingkat Bahaya Tanah Longsor Kecamatana Banjarsari

INDEKS BAHAYA TANAH LONGSOR LUAS
NO Tingkat Bahaya Nilai Bahaya Ha %
Tanah Longsor Tanah Longsor
1 | Rendah 7-9 3639.94 24
2 | Sedang >9-12 10522.10 72
3 | Tinggi >12-15 637.03 4
TOTAL 15142.27 100
(Sumber : Analisa penulis, 2024)
Tabel 5.6 Batas Desa
LUAS
NO NAMA DESA Ha %
1 Bendungan 621922 4%
2 Bojong Juruh 122895 8%
3 Cilegongilir 758,190 5%
4 Ciruji 493325 3%
5 Cisampih 905,173 6%
6 Gunun gsari 629,766 4%
7 Jalupang Girang 551850 4%
8 Cibaturkesik 241 944 2%
9 Cidahu 52944 3%
10 Kaduhauk 306,744 2%
11 Kerta 133329 9%
12 Kertaraharja 139145 9%
13 Kertarahayu 809,93 5%
14 Keusik 556,10 4%
15 Kumpay 68644 5%
16 Leban Jaya 346,72 2%
17 Lebak Keusik 1000.28 7%
18 Leuwi Piuh 1476.61 10%
19 Tamansari 754.71 5%
20 Umbul Jaya 501.60 3%
Total 1514227 100%

(Sumber : Analisa penulis, 2024)

Tabel 5.7 Tingkat Bahaya Tanah Longsor Berdasarkan Desa

LUAS TINGAT BAHAYA (Ha)
NO Nama o
Desa Ha % Rendah Sedang Tinggi
1 Bendungan | 621,922 49 187.63 403.45 1823
2 Bojong Juruh | 1228 95 8% 344.12 845.86 2304
3 Cilegongilir | 758,190 5% 0 661.97 9008
4 Ciruji 493,325 3% 128.36 321.63 2104
5 Cisampih | 905,173 6% 2.17 800.83 8571




6 Gunungsari | 629,766 4% 5307 510.59 43.10
7 Jalupang 551,850 4% 17.57 508.92 1454
Girang
8 Cibaturkesik | 241,944 2% 1.39 223.23 6.32
9 Cidahu 52944 3% 135.61 3595 26.17
10 Kaduhauk | 306,744 2% 67.10 226.36 1.91
11 Kerta 133329 9% 641.03 6497 7.54
12 Kertaraharja | 139145 9% 456.02 883.18 2268
13 Kertarahayu | 80993 5% 96.34 683.51 1897
14 Keusik 556,10 4% 88.12 426 54 1503
15 Kumpay 686 44 5% 257.60 380.85 18.67
16 Leban Jaya | 346,72 2% 0 285.98 60.10
17 | Lebak Keusik | 100028 7% 323.80 641.35 16.13
18 Leuwi Piuh | 147661 10% 391.10 924.10 128.28
19 Tamansari | 754.72 5% 216.34 518.85 19.53
20 Umbul Jaya | 501,60 3% 232.77 265.70 0.09
Total 15142.30 | 100 3639.94 10522.10 637.03
(Sumber : Analisa penulis, 2024)
Tabel 5.8 Daftar Aspek Fisik Di Kecamatan Banjarsari
FISIK
No Jenis FisiK Jumlah
1 | Permukiman (rumah) 12226
2 | Sekolah 50
6 | Mesjid 12
7 | Pasar 3
10 | Bangunan 424
11 | PUSKESMAS 2
12 | Rumah Sakit 0
(Sumber : Analisa penulis, 2024)
Tabel 5.9 Kerentanan Fisik Tanah Longsor Kecamatan
Banjarsari
KERENTANAN TANAH LONGSOR
TERHADAP FISIK
KECAMATAN TITIK TINGAT BAHAYA
BANJARSARI
No | Fisik Kecamatan Jumlah Tinggi | Sedang | Rendah
1 |Permukiman (rumah) 12.226 558 7781 3.887
2 |Sekolah 50 0 30 20
3 Mesjid 19 0 10 9
4 |Pasar 3 0 2 1
5 |Bangunan 424 20 316 88
6 |PUSKESMAS 2 0 0 2
7 |Rumah Sakit 0 0 0 0
TOTAL 12.724 578 8.139 4.007

(Sumber : Analisa penulis, 2024)
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LOKASI : Leuwi Ipuh, Cilegon Ilir, dan Cisampih

Desa Cilegon Hir

Desa Cisampih

Desa Leuwi Ipuh

Desa Cilegon llir
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Modul Tutorial

Modul ini bertujuan memberikan panduan teknis dan operasional bagi pengguna

QGIS untuk:

« Mengolah dan mengklasifikasi parameter kerentanan tanah longsor.
« Menggabungkan parameter menggunakan metode overlay raster.
« Menghasilkan peta kerentanan tanah longsor yang siap ditampilkan dan

dicetak.

Peralatan & Data

A. Aplikasi:

* QGIS versi 3.x (gratis dan open source)

B. Data Spasial yang Dibutuhkan:

Parameter Format Sumber Data Contoh
Digital Elevation Model .
(DEM) Raster (.tif) SRTM 25m (BIG)
Peta Jenis Tanah Shapefile BIG
Peta Geologi (Jenis Batuan) Shapefile FAO
Peta Potensi Gerakan Tanah  |[Shapefile/Raster PVMBG atau manyzl
klasifikasi
Batas Administrasi (opsional) |[Shapefile BPS

>45% 5 Sangat Miring
25-45% 4 Miring

Kemiringan 15-25% 3 25 Agak Miring
Lereng 8-15% 2 Landai
0-8% 1 Datar
) Vulkanik 3 Rawan

Geolog! Sedimen 1 25 Tidak Rawan
Potensi — —
Pergerakan Tinggi 4 Tinggi

Tanah menengah 3 5 menengah

Rendah 2 Rendah




Sangat Rendah 1 Sangat Rendah
A070-2/3a Acrisols . .
lithic) 4 Tinggi
Agl5-2/3a Acrisols . .
Jenis Tanah (Podzolic) 4 25 Tingei
enis fanall 1y 83-2/3c Acrisols A Tins
lithic) nget

I. Langkah-Langkah Operasional QGIS
Langkah 1: Buka Aplikasi QGIS

« Jalankan QGIS Desktop

« Buat proyek baru:

Project > New

@ Untitled Project — QGIS
Y Edit View Layer Settings

Plugins  Vector
Ctri+N

New frem Template

Langkah 2: Tambahkan Layer Data

e Pilih: Layer > Add Layer > Add Vector Layer untuk shapefile (.shp)
s Pilih: tayer > Add Layer > Add Raster Layer untuk file DEM ( tif)
« Pastikan semua layer menggunakan sistem proyeksi yang sama (karena

provinsi banten ada di zona 48 lintang selatan maka manggunakan

EPSG:4326 — UTM Zone 48S)




II. Pengolahan Parameter

A. Kemiringan Lereng (Dari DEM)
Tujuan: Mengidentifikasi area curam yang rawan longsor
Langkah:

1. Menu: Raster > Rnalysis > Slope

o Input: Layer DEM
o Output: Slope raster dalam derajat




EER wee Men Progessing pep

icudtor.. " Ty .
d @ b 3
Align Rasters
FE “.

Projectiont +| 2 i nodes.
Maceianeous | g Gnd (Moving dverage
Extraction +| [ Grid Dt Metrics).

G (Invesse Distance to s Power]
i G Mowarmst Meighber)

& Miknsse

) Mo Brach

Converson

7 Prowimity Raster Distance)
& P
L Seve

& Tepograph Poston indes ()
i Tervam Ruggedness indes (15

2. Setelah selesai membuat slope, kemudian membuat klasifikasi kelas lereng
dengan klik menu procesing > pada procesing toolbox pilih Reclasify >
reclasify by table

Processing Toclbex [« |
e O N
~ () Raster analysis =

15 Cell stack percent rank from value

188 Cell stack percentile

48 Cell stack percentrank from raster la...
Cell statistics

¥ Equal to frequency

Fuzzify raster (gaussian membership)

Fuzzify raster (large membership)

Fuzzify raster (linear membership)

Fuzzify raster (near membership)

Fuzzify raster (power membership)

« Fuzzify raster (small membership)

Greater than frequency

Highest position in raster stack

¢ Less than frequency
% Lowest position in raster stack Help
Raster boolean AND = —
Raster boolean OR N -3§.$' Toolbox Ctrl+Alt+T
Raster calculator i
¢ Raster layer properties s Graphical Modeler... Ctrl+Alt+G
Raster layer statistics .
Raster layer unique values report 1) History... Ctrl+Alt+H

Raster layer zonal statictics
Raster surface volume

Results Viewer Ctrl+Alt+R

s A Edit Features In-Place




3. Pada reclasify by table kemudian pada raster input gunakan raster yang
telah dibuat sebelumnya > klik kotak kecil sebelah kanan pada
reclasifycation table

() Reclassify by Table

Parameters | Log

Raster layer

I " Banjarsari Lebak_SLOPE [EPSG:32748] - I
Band number

Band 1 (Gray) >
Redassification table

Fixed table (0x3) D

w Advanced Parameters

Qutput no data value

-9999.000000 =
Range boundaries

min < value <=max -

Use no data when no range matches value
Output data type
Float32 -

Redassified raster

[Save to temporary file]

V| Open output file after running algorithm

4. Lalu Add Row sesuaikan dengan peraturan yang berlaku pada penelitian
nilai masukan disesuaikan dengan Tabel 5.1 (Halaman:31)

Parameters Log
4 | Redassification table

Minimum Maximum Value Add Row

Remove Row(s)
Remove All
OK

Cancel




5. lJika selesai kemudian klik OK. pada tampilan selanjutnya pada pilihan
Advanced Parameters > pilih (min<=value<max) > Simpan Project lalu >
RUN.

) Recassily by Tabke *

Parameters | Log
Raster e

B Barjersan Lebek_SLOPE [EPSG: 32748] -
Band number

Bard 1 (Gray) =

i < vl <= ma

min <= valut <= man

mn < wale < man

Qedazsfed roster

v Open outpat fle ftes ruswang akgonttm

Advanced * | Run 36 Batch Process Run Che Hep

6. Lakukan simbologi pada hasil klasifikasi tersebut dengan klik kanan pada
hasil klasifikasi > properti > simbologi > atur dan sesuaikan notasi
kemiringan lereng sesuai dengan yang di inginkan > OK

Layars (2 (R

o W e T & Tl
(1] Atribut Tabel Kemidngsn Leren
o & Lertreale_ K o

v Zoom to Layer(s)

wered detrerbe_%
* ¥ B Banjerasari Lebak_[ ™ Show in Qverview

Capy Laywr

Rename Layar
SV Zoowm ta Natjve Resalution (1007%6)

Streteh Using Current Extent

L) Duplicate Layer
4 Bemove Layar...

Maove ta Top
Move to Bottom
Check and All its Parents
Change Data Source
Set Layer Scale Yisibiln
Layer CRS .
Export

Styles .
Add Layer Notes, .

Browser () | Browser




GO Loy Pragesties — b Lobet Rechonty — Symboiogy x
w Sanl fendermg -
Rereer e | gebarc umchceis

(o Bt | fray)

Iespaater, - -
G vy L e

Lo st |
Laelrecomn . e ||
Vb Color Ll

7. Selanjutnya yaitu mengubah layer dari Raster menjadi Poligon dengan
cara pilih Menu Raster > Conversion > Polygon (Raster to Polygon).

Plugins Vector LEBC Web Mesh Progessing Help
@ i:‘ pe) ¥ Raster Calculator... ( E} H !: 1 (3 e
Align Rasters...
] A Analysis y =5 @
Projections ]
Miscellaneous v
Extraction »
= PCTtoRGB...

“~ Rasterize (Vector to Raster)...
% RGBtoPCT.
%, Transiate (Convert Format)...

8. Pada tampilan berikutnya pastikan data masukan sudah benar > Save File
> RUN.




G Poiygonze [Raster to Yector)
L™

v
Borprsan Lebaw_Recosfy [EPSG: 1274] -

Band I fGrmy)
haare of ek ta e

Lo 3 corme e

¥ Advanced Pammeters

Additeral comrrars drw parere ey [optione]
vecmned
o e ot fle s g akgnthon

GO JOGR: conscle ool

Lebek Reclasfy.af b 1-F

= : RevAT, STPUIT g CLITPLIT
on

Acvarced © Rur o Batch Process

9. Peta untuk parameter kemiringan telah selesai.

TAELLTAS ORI
N IVERIITA A TAN ACENG TIRTAYATA

Bagaran Lebak_Keminngan Lereng
. O

0 unca

1 Aok curam

[ Curam

[ sangst Cursm




B. Jenis Tanah
Tujuan: Memberi bobot tanah berdasarkan potensi retak atau pelapukan

Langkah:

B oMo Lo
9, 440 Debrted Tt Layes

W, LigPonaS e

£ M0 malieime G St
M 40045 SN S L
| Lad O Syl Laves Cio Siehe0)

W, L AP HANE Spatin Lape

B M0t s L

Cat St
b 1T Lagn
i ) NS Loy

1 i at
W e R ST Snrves Loy
) 2 vacten The Lapee

T5 AdePrant Clzusd Layms.

D

5 Ao DK Ly

o Shom Al i Oversies

| 22 baata st traam, G

1. Buka atribut tabel shapefile jenis tanah dengan klik kanan pada data
masukan jenis tanah > Open Atribute Table

Layers [T
«ReY5-320

Shom Faaturs Count

= ¥ O Cipped
v [l ag1 = ShowLebes
v Aol Copy Layer
o v [l A Repuene Layer
« ¥ ¥ EsRiSes L] Duphcate Layer
. 03M | [ Bemove Layer..
Move to Top

Move to Bottom

J/ Toggle [diting
Fiftec..
Change Dats Source

Sen Layer Scale isibality...

Layer CRS M

Export N
Groveer () Broy Styles 0
Add Layes Notes...




2. Tambahkan kolom baru: Score dan Bobot (tipe: integer) dengan memilih
Toogle Editing Mode > New Field

3. Pada tampilan berikutnya tentukan tipe kolom baru dengan data yang akan
dibuat

() Add Field X
Name |
Comment
Type 123Integer (32 bit) hd
Provider type integer
Length 10 =

[ oK | cancel

4. Isikan skor dan bobot sesuai dengan parameter jenis tanah seperti pada
tabel 5.3 (Halaman : 34) > simpan atribut tabel

FAOSOIL DOMSOI COUNTRY SKORIT

Bobot_IT
1}Ac83-2/3¢ Ao INDONESIA 4.000
2/ Agl15-2/3a Ag INDONESIA 4.000
3| Ao70-2/3b Ao INDONESIA 4.000

Selanjutnya melakukan simbologi dengan klik kanan pada layer
>propertys>symbology




6. Sesuaikan pewarnaan simbol dengan mengatur warna sesuai yang
diinginkan dengan value menggunakan field jenis tanah > Apply/Ok
7. Peta untuk parameter kemiringan telah selesai

PETA JENIS TANAH KECAMATAN BANJARSARI

C. Jenis Batuan / Geologi

Tujuan: Menentukan kerentanan berdasarkan jenis batuan yang mudah
lapuk atau retak

Langkah:

W, atomaczeLayes,
[P

B e vacten The Lapes
B de st Cnud Layms

5 e X Ly

4 R Loy Ty el

o Shvam 4l i1 e

% ate 4 prem Cvwrow

1. Buka atribut tabel shapefile batuan/geologi dengan klik kanan pada data
masukan jenis tanah > Open Atribute Table




Hee e fomarm

e
S L Seate s

Ly O35 .
fupen

e

' A Lapes Phcten

2. Tambahkan kolom baru: Score dan Bobort (tipe: integer) dengan memilih
Toogle Editing Mode > New Field
@ Clipped — Features Tot

? e 2 & in‘f’fi',i"'ﬂ“o?ﬁ =

abcFADS ~ [= £ | abc

3. Pada tampilan berikutnya tentukan tipe kolom baru dengan data yang akan
dibuat

(2 Add Field b
Name [

Comment

Type 123Integer (32 bit) v

Provider type integer
Length 10 =

4. Isikan skor dan bobot sesuai dengan parameter jenis batuan/geologi seperti
pada tabel 5.2 (Halaman : 33) > simpan atribut tabel




Q) grotog By — Festures Totet 11 Fiberedt. 1), Selected: &

<] & "TERSE FE & &5
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10 abial At e 1 L]
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300 Bt gurvang . Chmsetersery vol arssol 1 »
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5. Selanjutnya melakukan simbologi dengan klik kanan pada layer
>propertys=>symbology

2 Goo — geeiog il pbcn o
v Py ——
[Pa—
Open trisnts Tass.
T bty
Fom
[ —
S Ly S iy

Loy (RS
Eapant

6. Sesuaikan pewarnaan simbol dengan mengatur warna sesuai yang
diinginkan dengan value menggunakan field jenis tanah > Apply/Ok
7. Peta untuk parameter jenis batuan/geologi telah selesai.




D. Potensi Gerakan Tanah

Tujuan: Menggunakan klasifikasi PVMBG atau interpretasi potensi longsor

Langkah:

1. Buka atribut tabel shapefile batuan/geologi dengan klik kanan pada data
masukan jenis tanah > Open Atribute Table

Loy B

2. Tambahkan kolom baru: Score dan Bobot (tipe: integer) dengan memilih
Toogle Editing Mode > New Field
(@ Clipped — Features T
-

abcEAQS ¥ |=| £ | |abc

3. Pada tampilan berikutnya tentukan tipe kolom baru dengan data yang akan

dibuat
() Add Field X
MName |
Comment
Type 123Integer (32 bit) v
Provider type integer
Length 10 =




4. Isikan skor dan bobot sesuai dengan parameter jenis batuan/geologi seperti
pada tabel 5.2 (Halaman : 33) > simpan atribut tabel

Q groog sy — Festiee Tost 11, Fimreet 1), Selectedt O

<] L ATRS S FE & & 5
SWBCL NaE - LUAS He Shoar Gen Betion G
10 bl HEw i ]
1 ekt Anggots Batup Bayengesani F.. 1533 3 n
300 st gurang. Chaarternary vol arvssel 1 3
4 ogkt FremniBuong  Beieng Fermat,. o4 3 n
3 cewt Vo Bryong  Bayzng Format, wan 1 n
© bl Fraemeasi Bojorg... Bojengeanit F. ) 3 .}
T o1 Fooma Boyony.. Bayengeeni F. 48 844 3 b
1% Foomwms Cibow Cibos Fermation. EUE 1 )
¥ e Fmmass Cimagsy. Cemapag Form s 1 L
bt Frmmaan Cipacar Cipacar Formas 1 B
1 kg! Frmasi Gestang  Gemtere Forema 1l n
1 Ol Produk guning.. Lameng welcam. s 1 F
1o [Ty r—— s 1 »

5. Selanjutnya melakukan simbologi dengan klik kanan pada layer
>propertys>symbology
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6. Sesuaikan pewarnaan simbol dengan mengatur warna sesuai yang
diinginkan dengan value menggunakan field jenis tanah > Apply/Ok
7. Peta untuk parameter jenis batuan/geologi telah selesai.




II1. Analisis Overlay (Gabungan Raster/Polygon)
Pastikan:

« Semua layer parameter shp sudah dalam targer CRS yang sama
« Semua layer parameter sudah memiliki nilai skor dan bobot

Langkah:

1. Buka semua Shape File semua parameter yang sudah dibuat sebelumnya
(shp kemiringan lereng, shp jenis tanah, shp jenis batuan/geologi, dan shp
potensi pergerakan tanah) dengan pilih layer > add layer

Bl s Doom ot bow b oh Proceswy beb
-

- bl | ; Lo

6 ade bt Cleus et

5 ke 0P e

T vy —




2. Sampai shp semua parameter terbuka pada layer panel

Layers E]ES)
O TV o-FADO
v [l Potensi Gertan
vl
v [] Geo
v! [l Kelerengan

3. Mulai lakukan penggabungan lapisan (overlay) pada semua shp parameter
dengan cara pada laver panel kemiringan lereng pilih Vector
>Geoprocesing Tool > intersect

*pada aplikasi Quantuum GIS proses overlay tidak bisa langsung sekaligus semua
parameter (bertahap per/lapisan)

Shegra Baster Yok Mo Progmany tep
™ g I 2w
U y

# Oy

B
o Camom P
: |

4. Pada tampilan selanjutnya jadikan shp kemiringan lereng (input layer) dan
shp jenis tanah (overlay layer)> save file > Run. Jadilah shp overlay
kel_JT atau overlay antara parameter kemiringan lereng dan jenis tanah.

[Ee——

5. Selanjutnya lakukan tahap yang sama untuk melanjutkan proses overlay
dimana shp Kel_JT yang telah dibuat sebagai masukan (inpur layer) dan

shp jenis batuan/geology (overlay layer). Penambahan lapisan telah selesai
untuk 3 paramter (kel_JT_Geo)




Ttersretion

P - e

6. Selanjutnya lakukan tahap yang sama untuk melanjutkan proses overlay
dimana shp Kel _JT_Geo yang telah dibuat sebagai masukan (input layer)
dan shp potensi gerakan tanah (overlay layer). Penambahan lapisan telah
selesai untuk semua paramter (kel_JT_Geo_Gertan)

' Intersection

7. Maka terciptalah peta baru hasil penggabungan lapisan semua parameter

8. Selanjutnya melakukan perhitungan untuk kelas dan bobot yang telah
dibuat pada masing masing parameter sebelumnya. Untuk mengetahui
kelas interval yang nantinya akan menunjukan indeks bahaya tanah

longsor

Gunakan Fielf Calculator

Langkah:




1. Lakukan langkah perhitungan lewat atribut tabel dari overlay yang telah
dibuat sebelumnya dengan pada panel klik kanan layer overlay > open
atribute table

Layen R

CE B ATE E g

[ i

Q

o ¥ e
v [l Potemi Gertan O Show in Queniew
v ! n Stiow Feature Coune
v [ Geo
| d Show |abel
v [l Dissohved Copy Layer
v Reprojected Rapperne Layer
* ¥ indels_adm bargarsari 7
v O« & L] Duptcate Layer
J « Remove Layer

Marre to Gottom

J Teggle Editing
[
Charcge Data Seamtn.
Set Layer Scale Yiskuiity...
Layer CRS .
Egpent .
Styles.

. Achd Layer Notes...

boweer (11 Growser  Layes  Propemies.

2. Maka akan tampil atribut tabel hasil penggabungan (everlay) dari semua
parameter
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3. Mulai lakukan dengan menambahkan fiel/d/kolom baru untuk total bobot
aktifkan toogle editing mode > new field

(@) KEL_IT_GERTAN_GEQ — Features Total: 1835, Filtered: 1835, Selected: 0
/e = B & A TESLR BERE B @@

12DN ~ (= £ 113




(Q Add Field X

Name
Comment
Type 123Integer (32 bit) -
Provider type integer
Length 10

'

4. Jika kolom total bobot telah dibuat selanjutnya yaitu tahap kalkulasi
indeks bahaya tanah longsor dengan open field calculator.

) KEL_IT_GERTAN_GED — Features Total 1831, Fiered: 1835, Selected: 0
! | € YR OX

gy = i wm

Open Field calculstar (Ctrls 1)
5. Pada tampilan selanjutnya centang mode update existing field > pilih field

Total Bobot (agar hasil kalkulasi tepat hanya pada kolom indeks yang baru
dibuat)

P —— 3

6. Selanjutnya masukan persamaan sesuai pada halaman 24.

Dalam kolom expresion masukan persamaan seperti dibawah ini

Formula expresion pada field calculator:

plaintext

CopyEdit

("bobot kel™ * 0.25) +
("bobeot JT"™ * 0.25) +
("bobot Geo™ * 0.25) +
("bobot Gertan™ * 0.25)




Setiap input bobot lakukan dengan mengklik pilihan pada menu feature geometry
id row_number.

¥ Comate & e bkt it sy Sk

e —ry———

B e L4

7. Maka total bobot keseluruhan telah didapatkan, dimana pada penelitian ini
didaptkan nilai minimum 175 dan nilai maksimun 325.

TOTAL BOBO < TOTAL BOBO ~
175 - 325

8. Selanjutnya menentukan indeks bahaya (rendah, sedang, dan tinggi) tanah
longsor dengan menghitung kelas interval berdasarkan nilai bobot total
dari semua parameter. Dengan persamaan sesuai yang tertera pada
halaman 24.

Secara matematis interval kelas tingkat bahaya dirumuskan sebagai berikut
(Cahyaningrum,2014)

Interval Kelas = Skor Maksimum—Skor Minimum

Jumlah Kelas




9. Didapat kelas interval 50 maka bobot total 175-225 (rendah), 225-275
(sedang), dan 275-325 (tinggi)

Nilai Skor Akhir Tingkat Kerentanan

<225 Rendah
225-275 Sedang
>275 Tinggi

10. Kemudian pada atribute table tambahkan kolom indeks dan dilakukan
pengisian keterangan sesuai dengan kelas indeks yang didapatkan dari
hasip perhitungan diatas.

11. Selanjutnya melakukan penghitungan luasan wilayah dari masing masing
indeks bahaya.

12. Yaitu pertama buat kolom baru dengan judu “Luas” pada atribt tabel.

13. Pada tampilan selanjutnya centang mode update existing field > pilih field
“luas’>

FEERETTRFENGESHI Y

14. Pada kolom expresion masukan formula $area(indeks) dengan
memilihnya pada geometry. Untuk menghitung luasan masing masing
indeks




et o bkl R
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15. Maka pada atribut tabel pada kolom indeks akan otomatis terhitung luasan
masing-masing indek

INDEKS — LUAS INDEK

i RENDAH 2.29
i RENDAH 239
i RENDAH 4379.57
i RENDAH 113.43
i RENDAH 5.63

IV. Tingkat Kerentanan fisik

Yaitu dengan melakukan proses overlay pada peta indeks bahaya yang telah
dibuat dengan peta sebaran fisik pada lokasi tinjauan.

Tabel 5.8 Daftar Aspek Fisik Di Kecamatan Banjarsari

FISIK

No Jenis FisiK Jumlah

1 Permukiman (rumah) 12226
2 [lah 50

6 | Mesjid 12

7 | Pasar

Bangunan 424

11 | PUSKESMAS 2




| 12 | Rumah Sakit 0 |
(Sumber : Analisa penulis, 2024)

Kemudian mengitung persentase aspek fisik yang terdampak
(rendah, sedang, dan tinggi) pada masing masing desa dengan
menggunakan Ms.Excel.

V. Visualisasi Peta

Langkah:
1. Klik kanan pada layer hasil akhir > Properties
2. Pilih tab Symbology
3. Mode: Singleband pseudocolor
4. Atur warna:

o Hijau = Rendah
o Kuning = Sedang
o Merah =Tinggi

VI. Penyusunan Peta di Layout

Langkah:

1.

Menu: Project > New Print Layout

2. Tambahkan:

3.

Main Map
Legend
Scale Bar
North Arrow
Judul
o Sumber Data
Export ke:
o PDF (Layout > Export as PDF)
o Gambar (Layout > Export as Image)

0 0 o 0

VIIL. Output Akhir

Peta SHP Zona Indeks dan Kerentanan Kerentanan Fisik Longsor
Layout Peta (PDF/PNG)
Proyek QGIS (.qgz) yang dapat dibuka ulang




VIII. Tips Tambahan

e Gunakan Group Layer untuk mengelola data
« Simpan proyek secara berkala

e Simpan hasil raster ke folder terstruktur

» Gunakan Bookmarks untuk area fokus
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